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20894 Bug report Closed Normal QGIS 3.5 python-qgis broken (install) on Ubuntu 2018-12-31 08:49 PM No

20894 Bug report Closed Normal QGIS 3.5 python-qgis broken (install) on Ubuntu 2018-12-31 08:49 PM No

20870 Bug report Closed Normal 'gdal_fillnodata.bat' is not recognized as an internal or external command 2019-01-07 05:15 PM No

20870 Bug report Closed Normal 'gdal_fillnodata.bat' is not recognized as an internal or external command 2019-01-07 05:15 PM No

20860 Bug report Closed Low QGIS crashing possibly during drives refresh 2018-12-21 12:05 AM No

20860 Bug report Closed Low QGIS crashing possibly during drives refresh 2018-12-21 12:05 AM No

20834 Bug report Closed Normal Project -> Properties crashes with LANG != C 2019-01-04 11:13 AM No

20834 Bug report Closed Normal Project -> Properties crashes with LANG != C 2019-01-04 11:13 AM No

20827 Bug report Closed Normal QGIS3.4.1 crashes after short period inactivity 2018-12-17 11:46 PM No

20827 Bug report Closed Normal QGIS3.4.1 crashes after short period inactivity 2018-12-17 11:46 PM No

20822 Bug report Closed Normal Batch buffer does not start and crashes application 2018-12-17 07:05 AM No

20822 Bug report Closed Normal Batch buffer does not start and crashes application 2018-12-17 07:05 AM No

20820 Bug report Closed Normal QGIS 3.4 crashed when using ArcGIS MapServer and FeatureServer 2018-12-16 08:25 PM No

20820 Bug report Closed Normal QGIS 3.4 crashed when using ArcGIS MapServer and FeatureServer 2018-12-16 08:25 PM No

20810 Bug report Closed High QGIS Server 3 - drawing order of grouped layer Alessandro 

Pasotti

2019-01-09 09:41 AM No

20810 Bug report Closed High QGIS Server 3 - drawing order of grouped layer Alessandro 

Pasotti

2019-01-09 09:41 AM No

20807 Bug report Closed Normal Cannot Install to Fedora 29, 64-bit 2018-12-14 06:31 PM No

20807 Bug report Closed Normal Cannot Install to Fedora 29, 64-bit 2018-12-14 06:31 PM No

20799 Bug report Closed Normal Distance matrix output is false 2018-12-17 02:22 PM No

20799 Bug report Closed Normal Distance matrix output is false 2018-12-17 02:22 PM No

20788 Bug report Closed High Error whilst running delete duplicates algorithm in QGIS 3.4 2018-12-17 02:22 PM No

20788 Bug report Closed High Error whilst running delete duplicates algorithm in QGIS 3.4 2018-12-17 02:22 PM No

20767 Bug report Closed High Crash Processing Modeler 2018-12-11 10:27 PM No

20767 Bug report Closed High Crash Processing Modeler 2018-12-11 10:27 PM No

20764 Bug report Closed Normal Duplicate QGIS entry in Ubuntu launcher Jorge Rocha 2018-12-10 06:52 PM Yes

20764 Bug report Closed Normal Duplicate QGIS entry in Ubuntu launcher Jorge Rocha 2018-12-10 06:52 PM Yes

20733 Bug report Closed High Attribute table: Order of columns doesn't persist 2018-12-19 09:05 PM No

20733 Bug report Closed High Attribute table: Order of columns doesn't persist 2018-12-19 09:05 PM No

20713 Bug report Closed Normal Processing gdal sieve: mask parameter should be optional (and is not possible to get rid of it) Giovanni 

Manghi

2019-01-01 03:26 PM No

20713 Bug report Closed Normal Processing gdal sieve: mask parameter should be optional (and is not possible to get rid of it) Giovanni 

Manghi

2019-01-01 03:26 PM No

20696 Bug report Closed High Processing: r.plane does not run successfully 2018-12-03 11:54 PM No

20696 Bug report Closed High Processing: r.plane does not run successfully 2018-12-03 11:54 PM No

20674 Bug report Closed High DB Manager - load sql query as layer with geom column Alessandro 

Pasotti

2018-12-19 05:23 PM Yes

20674 Bug report Closed High DB Manager - load sql query as layer with geom column Alessandro 

Pasotti

2018-12-19 05:23 PM Yes

20656 Bug report Closed High Identify feature task never stop on Spatialite layer 2018-11-30 08:49 AM No

20656 Bug report Closed High Identify feature task never stop on Spatialite layer 2018-11-30 08:49 AM No

20649 Bug report Closed Normal QGIS Crash 2018-11-27 08:40 PM No

20649 Bug report Closed Normal QGIS Crash 2018-11-27 08:40 PM No

20620 Bug report Closed High [geometry validation] saving edits does not work 2018-12-11 01:35 PM No

20620 Bug report Closed High [geometry validation] saving edits does not work 2018-12-11 01:35 PM No

20610 Bug report Closed Normal Add default parameter in GDAL contour 2018-12-30 02:59 PM No

20610 Bug report Closed Normal Add default parameter in GDAL contour 2018-12-30 02:59 PM No

20591 Bug report Closed Normal Dissolve tool failing to produce outputs Alessandro 

Pasotti

2018-11-23 01:51 PM Yes

20591 Bug report Closed Normal Dissolve tool failing to produce outputs Alessandro 

Pasotti

2018-11-23 01:51 PM Yes

20580 Bug report Closed Normal Legend - Filter legend by map content not working 2018-11-22 09:44 AM No

20580 Bug report Closed Normal Legend - Filter legend by map content not working 2018-11-22 09:44 AM No

20549 Bug report Closed Normal QGIS SERVER - error in parsing WMS GetFeatureInfo as XML Alessandro 

Pasotti

2018-11-28 08:01 AM No

20549 Bug report Closed Normal QGIS SERVER - error in parsing WMS GetFeatureInfo as XML Alessandro 

Pasotti

2018-11-28 08:01 AM No

20515 Bug report Closed High Attribute Table issue: the changes to the column settings are not persistent 2018-12-19 10:04 AM No

20515 Bug report Closed High Attribute Table issue: the changes to the column settings are not persistent 2018-12-19 10:04 AM No

20495 Bug report Closed High  crash when insert or eject usb storage 2018-11-15 03:11 AM No

20495 Bug report Closed High  crash when insert or eject usb storage 2018-11-15 03:11 AM No

20486 Bug report Closed High  python error while using virtual layers in db manager 2018-12-24 10:16 AM No

20486 Bug report Closed High  python error while using virtual layers in db manager 2018-12-24 10:16 AM No

20481 Bug report Closed Normal Symbol SVG window 2018-11-26 08:59 AM Yes

20481 Bug report Closed Normal Symbol SVG window 2018-11-26 08:59 AM Yes

20477 Bug report Closed High Floating windows cannot be scaled QGIS 3.4.1 macOS (10.11.6) Denis Rouzaud 2018-11-29 04:25 PM No

20477 Bug report Closed High Floating windows cannot be scaled QGIS 3.4.1 macOS (10.11.6) Denis Rouzaud 2018-11-29 04:25 PM No

20461 Bug report Closed Normal Can't click "browse" in "Handle bad layers" window Alessandro 

Pasotti

2018-11-13 08:49 AM No

20461 Bug report Closed Normal Can't click "browse" in "Handle bad layers" window Alessandro 

Pasotti

2018-11-13 08:49 AM No

20432 Bug report Closed High Missing "resampling method" and "overview format" in GDAL "create overviews" tool Giovanni 

Manghi

2019-01-01 12:38 PM No

20432 Bug report Closed High Missing "resampling method" and "overview format" in GDAL "create overviews" tool Giovanni 

Manghi

2019-01-01 12:38 PM No

20429 Bug report Closed High "Merge Selected Feature" with option "Take Attributes from selected feature" do not respect postgres-provider default 

values

2018-11-23 12:44 PM No
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20429 Bug report Closed High "Merge Selected Feature" with option "Take Attributes from selected feature" do not respect postgres-provider default 

values

2018-11-23 12:44 PM No

20423 Bug report Closed High CRASH wnhen I close it.... 2018-11-09 08:28 PM No

20423 Bug report Closed High CRASH wnhen I close it.... 2018-11-09 08:28 PM No

20418 Bug report Closed High PostGIS Split Fails With Data Loss 2019-01-05 08:37 PM No

20418 Bug report Closed High PostGIS Split Fails With Data Loss 2019-01-05 08:37 PM No

20412 Bug report Closed High Distance matrix 2018-12-24 09:08 AM No

20412 Bug report Closed High Distance matrix 2018-12-24 09:08 AM No

20382 Bug report Closed High [DB Manager] Unable to expand the Virtual Layers --> Project Layers group in the tree 2018-11-10 09:55 AM No

20382 Bug report Closed High [DB Manager] Unable to expand the Virtual Layers --> Project Layers group in the tree 2018-11-10 09:55 AM No

20378 Bug report Closed Normal QGIS 3.4 cannot install on Mac William 

Kyngesburye

2018-11-06 03:44 PM No

20378 Bug report Closed Normal QGIS 3.4 cannot install on Mac William 

Kyngesburye

2018-11-06 03:44 PM No

20368 Bug report Closed Normal CRITICAL Error CL_PLATFORM_NOT_FOUND_KHR searching for OpenCL device: clGetPlatformIDs Alessandro 

Pasotti

2018-11-05 05:26 PM No

20368 Bug report Closed Normal CRITICAL Error CL_PLATFORM_NOT_FOUND_KHR searching for OpenCL device: clGetPlatformIDs Alessandro 

Pasotti

2018-11-05 05:26 PM No

20360 Bug report Closed Normal WMS with DEFAULT Styles fails 2018-11-05 09:50 AM No

20360 Bug report Closed Normal WMS with DEFAULT Styles fails 2018-11-05 09:50 AM No

20358 Bug report Closed Normal Layer Styling > Save Symbol crashes QGIS 2018-11-04 11:58 PM No

20358 Bug report Closed Normal Layer Styling > Save Symbol crashes QGIS 2018-11-04 11:58 PM No

20324 Bug report Closed Normal QGIS Crash 2018-11-02 03:28 AM No

20324 Bug report Closed Normal QGIS Crash 2018-11-02 03:28 AM No

20321 Bug report Closed Normal Scale Bar decoration is not displayed - 3.4 - macOS 2018-11-25 05:16 PM No

20321 Bug report Closed Normal Scale Bar decoration is not displayed - 3.4 - macOS 2018-11-25 05:16 PM No

20310 Bug report Closed High External windows size not changeable, MacOS 2018-11-25 05:17 PM No

20310 Bug report Closed High External windows size not changeable, MacOS 2018-11-25 05:17 PM No

20306 Bug report Closed High Browse button no longer works (greyed out) in Handle Bad Layers Dialog 2018-11-01 04:44 AM No

20306 Bug report Closed High Browse button no longer works (greyed out) in Handle Bad Layers Dialog 2018-11-01 04:44 AM No

20261 Bug report Closed High python script crashes QGIS 2018-10-30 11:37 PM No

20261 Bug report Closed High python script crashes QGIS 2018-10-30 11:37 PM No

20255 Bug report Closed High Impossible to enter a decimal value for the geometry precision in French (comma as decimal separator) Alessandro 

Pasotti

2018-10-29 02:31 PM Yes

20255 Bug report Closed High Impossible to enter a decimal value for the geometry precision in French (comma as decimal separator) Alessandro 

Pasotti

2018-10-29 02:31 PM Yes

20253 Bug report Closed Normal UI : QGIS 3.4 Font are too small on Bottom toolbar (navigator and projection) 2018-11-05 02:39 PM No

20253 Bug report Closed Normal UI : QGIS 3.4 Font are too small on Bottom toolbar (navigator and projection) 2018-11-05 02:39 PM No

20249 Bug report Closed Normal pip missing from QGIS 3.4 on Windows Jürgen Fischer 2018-10-30 08:59 AM No

20249 Bug report Closed Normal pip missing from QGIS 3.4 on Windows Jürgen Fischer 2018-10-30 08:59 AM No

20246 Bug report Closed Normal packaging: icons/desktop/mimeinfo files should also be installed/processed on BSD landry Landry 

Breuil

2018-11-13 09:22 PM Yes

20246 Bug report Closed Normal packaging: icons/desktop/mimeinfo files should also be installed/processed on BSD landry Landry 

Breuil

2018-11-13 09:22 PM Yes

20230 Bug report Closed Normal Cannot export a GPKG layer into the same container but different layer name 2018-10-30 05:03 PM No

20230 Bug report Closed Normal Cannot export a GPKG layer into the same container but different layer name 2018-10-30 05:03 PM No

20227 Bug report Closed Normal dbmanager time execution query python error 2018-10-27 08:46 PM No

20227 Bug report Closed Normal dbmanager time execution query python error 2018-10-27 08:46 PM No

20226 Bug report Closed High vertex edit ignore topological editing when move a polygon boundary segment 2018-11-06 02:58 PM No

20226 Bug report Closed High vertex edit ignore topological editing when move a polygon boundary segment 2018-11-06 02:58 PM No

20224 Bug report Closed Normal Map Tips does not appear to align with cursor 2018-10-29 08:41 PM No

20224 Bug report Closed Normal Map Tips does not appear to align with cursor 2018-10-29 08:41 PM No

20193 Bug report Closed High DBManager fails to display error messages with virtual layers Alessandro 

Pasotti

2018-10-24 05:38 PM Yes

20193 Bug report Closed High DBManager fails to display error messages with virtual layers Alessandro 

Pasotti

2018-10-24 05:38 PM Yes

20154 Bug report Closed Normal Broken clustering method selection in GRASS v.cluster processing algorithm Giovanni 

Manghi

2018-10-19 01:56 PM No

20154 Bug report Closed Normal Broken clustering method selection in GRASS v.cluster processing algorithm Giovanni 

Manghi

2018-10-19 01:56 PM No

20139 Bug report Closed High Please make vertex panel to be able to delete a vertex in QGIS 3 2019-01-14 11:47 PM No

20139 Bug report Closed High Please make vertex panel to be able to delete a vertex in QGIS 3 2019-01-14 11:47 PM No

20114 Bug report Closed Normal [processing] no cell size option for IDW interpolation alg 2018-12-30 02:59 PM No

20114 Bug report Closed Normal [processing] no cell size option for IDW interpolation alg 2018-12-30 02:59 PM No

20113 Bug report Closed Normal Label tools not working on rule based labelling 2018-10-15 10:23 PM No

20113 Bug report Closed Normal Label tools not working on rule based labelling 2018-10-15 10:23 PM No

20112 Bug report Closed Normal error loading QGIS (3.2 and 3.3 nightly) 2018-10-23 05:00 PM No

20112 Bug report Closed Normal error loading QGIS (3.2 and 3.3 nightly) 2018-10-23 05:00 PM No

20103 Bug report Closed Normal Data Type Change in Clip Raster by Mask Layer 2018-10-13 10:34 PM No

20103 Bug report Closed Normal Data Type Change in Clip Raster by Mask Layer 2018-10-13 10:34 PM No

20094 Bug report Closed High Extracting z-coordinates takes ages and makes the system unresponsive Alessandro 

Pasotti

2018-10-18 08:19 PM Yes

20094 Bug report Closed High Extracting z-coordinates takes ages and makes the system unresponsive Alessandro 

Pasotti

2018-10-18 08:19 PM Yes

20093 Bug report Closed Low Save / Load style window allows to change text Denis Rouzaud 2018-10-12 04:28 PM No

20093 Bug report Closed Low Save / Load style window allows to change text Denis Rouzaud 2018-10-12 04:28 PM No

20086 Bug report Closed High Label tools not working on rule based labelling 2018-10-12 10:28 AM No

20086 Bug report Closed High Label tools not working on rule based labelling 2018-10-12 10:28 AM No

20074 Bug report Closed High Blank canvas after applying filter/query builder 2018-11-19 10:34 AM No
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20074 Bug report Closed High Blank canvas after applying filter/query builder 2018-11-19 10:34 AM No

20039 Bug report Closed High toolbar icons not correctly aligned 2018-12-27 04:48 PM No

20039 Bug report Closed High toolbar icons not correctly aligned 2018-12-27 04:48 PM No

20033 Bug report Closed High Column misalignment after operations on large geopackage 2018-10-11 09:57 AM No

20033 Bug report Closed High Column misalignment after operations on large geopackage 2018-10-11 09:57 AM No

20024 Bug report Closed High Loss Z value after copying point into another layer 2018-11-08 04:08 PM No

20024 Bug report Closed High Loss Z value after copying point into another layer 2018-11-08 04:08 PM No

20008 Bug report Closed Normal Very Slow Table Operations while the Table is Open 2018-10-17 05:24 PM No

20008 Bug report Closed Normal Very Slow Table Operations while the Table is Open 2018-10-17 05:24 PM No

20004 Bug report Closed Normal Raster Warp(reproject) - reading in file path incorrectly 2018-10-03 01:48 PM No

20004 Bug report Closed Normal Raster Warp(reproject) - reading in file path incorrectly 2018-10-03 01:48 PM No

19996 Bug report Closed Normal edit vertex tool act on polygon layer during edit a point geometry 2018-10-04 10:11 PM No

19996 Bug report Closed Normal edit vertex tool act on polygon layer during edit a point geometry 2018-10-04 10:11 PM No

19980 Bug report Closed Normal Copy and pasting part of style with geometry error Denis Rouzaud 2018-10-05 01:44 AM No

19980 Bug report Closed Normal Copy and pasting part of style with geometry error Denis Rouzaud 2018-10-05 01:44 AM No

19971 Bug report Closed Normal QGIS 3.3 MASTER dbmanager time execution query not present matteo ghetta 2018-10-04 08:45 PM No

19971 Bug report Closed Normal QGIS 3.3 MASTER dbmanager time execution query not present matteo ghetta 2018-10-04 08:45 PM No

19960 Bug report Closed Normal layer tree embedded widget provider's supportsLayer() method is never called 2018-10-10 06:08 PM No

19960 Bug report Closed Normal layer tree embedded widget provider's supportsLayer() method is never called 2018-10-10 06:08 PM No

19950 Bug report Closed High blocking of QGIS, if the edit in place functionality is used in the locator bar (with ef) on an non-modifiable layer Alessandro 

Pasotti

2018-09-26 02:20 PM No

19950 Bug report Closed High blocking of QGIS, if the edit in place functionality is used in the locator bar (with ef) on an non-modifiable layer Alessandro 

Pasotti

2018-09-26 02:20 PM No

19939 Bug report Closed Normal mesh: missing arrows around the edge of the canvas Peter Petrik 2018-10-25 01:17 PM Yes

19939 Bug report Closed Normal mesh: missing arrows around the edge of the canvas Peter Petrik 2018-10-25 01:17 PM Yes

19930 Bug report Closed Normal "Zoom to feature" does not work Alessandro 

Pasotti

2018-10-01 10:49 AM Yes

19930 Bug report Closed Normal "Zoom to feature" does not work Alessandro 

Pasotti

2018-10-01 10:49 AM Yes

19925 Bug report Closed Normal With nested models, outputs from child model do not appear in the dialog when run from the toolbox Nyall Dawson 2018-09-25 03:50 AM No

19925 Bug report Closed Normal With nested models, outputs from child model do not appear in the dialog when run from the toolbox Nyall Dawson 2018-09-25 03:50 AM No

19893 Bug report Closed Normal It's not possible to delete raster layers in geopackages on Windows Alessandro 

Pasotti

2018-09-20 10:03 AM Yes

19893 Bug report Closed Normal It's not possible to delete raster layers in geopackages on Windows Alessandro 

Pasotti

2018-09-20 10:03 AM Yes

19876 Bug report Closed Normal Export style categories. Checkboxes are inconsistent Denis Rouzaud 2018-09-18 01:40 PM No

19876 Bug report Closed Normal Export style categories. Checkboxes are inconsistent Denis Rouzaud 2018-09-18 01:40 PM No

19861 Bug report Closed Normal Browser: Impossible to delete GeoPackage table if the path has accents Even Rouault 2018-10-08 02:01 AM No

19861 Bug report Closed Normal Browser: Impossible to delete GeoPackage table if the path has accents Even Rouault 2018-10-08 02:01 AM No

19859 Bug report Closed Normal Style manager and Open styling panel use the same icon: confusing 2018-09-21 07:22 AM No

19859 Bug report Closed Normal Style manager and Open styling panel use the same icon: confusing 2018-09-21 07:22 AM No

19856 Bug report Closed High crash when viewing 3d citygml 2018-09-20 09:27 PM No

19856 Bug report Closed High crash when viewing 3d citygml 2018-09-20 09:27 PM No

19843 Bug report Closed Normal Update SQL Layer converts query to table name Alessandro 

Pasotti

2018-09-26 02:30 PM Yes

19843 Bug report Closed Normal Update SQL Layer converts query to table name Alessandro 

Pasotti

2018-09-26 02:30 PM Yes

19842 Bug report Closed Normal DB Manager does not load layer after a query 2018-09-20 09:25 PM No

19842 Bug report Closed Normal DB Manager does not load layer after a query 2018-09-20 09:25 PM No

19829 Bug report Closed High Loading georeferenced PDF crashes QGIS 2018-11-19 10:31 AM No

19829 Bug report Closed High Loading georeferenced PDF crashes QGIS 2018-11-19 10:31 AM No

19820 Bug report Closed High python error in terrain analysis relief 2018-09-13 01:22 PM No

19820 Bug report Closed High python error in terrain analysis relief 2018-09-13 01:22 PM No

19813 Bug report Closed High Create grid algorithm is broken 2018-09-11 01:36 PM No

19813 Bug report Closed High Create grid algorithm is broken 2018-09-11 01:36 PM No

19812 Bug report Closed Normal Unable to select object with only one layer loaded 2018-09-10 09:48 PM No

19812 Bug report Closed Normal Unable to select object with only one layer loaded 2018-09-10 09:48 PM No

19805 Bug report Closed Normal QGIS 3: Link to the user manual not working when running Danish version of QGIS - might be the same for other 

languages where the user manual is not translated 

QGIS 

Translation 

Team

2018-09-12 12:39 PM No

19805 Bug report Closed Normal QGIS 3: Link to the user manual not working when running Danish version of QGIS - might be the same for other 

languages where the user manual is not translated 

QGIS 

Translation 

Team

2018-09-12 12:39 PM No

19798 Bug report Closed Normal voronoi.py swallows exceptions 2018-09-08 11:11 AM Yes

19798 Bug report Closed Normal voronoi.py swallows exceptions 2018-09-08 11:11 AM Yes

19789 Bug report Closed High while panning and moving QGIS just crashed... 2018-11-09 02:00 PM No

19789 Bug report Closed High while panning and moving QGIS just crashed... 2018-11-09 02:00 PM No

19786 Bug report Closed Normal Error while saving batch algorithm to JSON file 2018-09-08 11:11 AM No

19786 Bug report Closed Normal Error while saving batch algorithm to JSON file 2018-09-08 11:11 AM No

19779 Bug report Closed Normal "Sample raster values" alg not usable from graphical modeler Olivier Dalang 2018-09-08 11:09 AM No

19779 Bug report Closed Normal "Sample raster values" alg not usable from graphical modeler Olivier Dalang 2018-09-08 11:09 AM No

19766 Bug report Closed Normal Project file extension (QGS) in uppercase is not recognized 2018-09-04 03:35 PM No

19766 Bug report Closed Normal Project file extension (QGS) in uppercase is not recognized 2018-09-04 03:35 PM No

19750 Bug report Closed Normal "To run another Processing algorithm" in Processing's ScriptTemplate.py is broken 2018-09-26 09:07 PM No

19750 Bug report Closed Normal "To run another Processing algorithm" in Processing's ScriptTemplate.py is broken 2018-09-26 09:07 PM No

19748 Bug report Closed Normal "Acceleration" label added in Options dialog title Alessandro 

Pasotti

2018-09-02 04:42 PM Yes

19748 Bug report Closed Normal "Acceleration" label added in Options dialog title Alessandro 

Pasotti

2018-09-02 04:42 PM Yes

19744 Bug report Closed Normal QGIS 3.3.0-master (b55ab2e6d4) crashes upon closing 2018-09-18 12:43 PM No
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19744 Bug report Closed Normal QGIS 3.3.0-master (b55ab2e6d4) crashes upon closing 2018-09-18 12:43 PM No

19743 Bug report Closed High New lines character is weirdly rendered in layout label item text, breaking expressions 2018-09-04 10:53 AM No

19743 Bug report Closed High New lines character is weirdly rendered in layout label item text, breaking expressions 2018-09-04 10:53 AM No

19721 Bug report Closed Normal Virtual layers show no feature when no filter string is set in the Query builder 2018-08-29 10:58 AM No

19721 Bug report Closed Normal Virtual layers show no feature when no filter string is set in the Query builder 2018-08-29 10:58 AM No

19704 Bug report Closed Normal Function is_closed() is not working 2018-08-29 10:59 AM No

19704 Bug report Closed Normal Function is_closed() is not working 2018-08-29 10:59 AM No

19695 Bug report Closed Normal Line Edit widgets for integer numbers with thousand separators enabled are  hard to edit Alessandro 

Pasotti

2018-09-02 04:41 PM Yes

19695 Bug report Closed Normal Line Edit widgets for integer numbers with thousand separators enabled are  hard to edit Alessandro 

Pasotti

2018-09-02 04:41 PM Yes

19690 Bug report Closed Normal Project crs updates to epsg:4326 when a geometryless layer is frst added to it 2018-08-29 11:38 AM No

19690 Bug report Closed Normal Project crs updates to epsg:4326 when a geometryless layer is frst added to it 2018-08-29 11:38 AM No

19689 Bug report Closed Normal Geometryless table are associated a epsg:4326 crs parameter and spatial properties 2018-08-29 11:38 AM No

19689 Bug report Closed Normal Geometryless table are associated a epsg:4326 crs parameter and spatial properties 2018-08-29 11:38 AM No

19673 Bug report Closed Normal MD5 mismatch in  QGIS Standalone Installer Version 3.2 (64 bit) 2018-08-23 12:05 PM No

19673 Bug report Closed Normal MD5 mismatch in  QGIS Standalone Installer Version 3.2 (64 bit) 2018-08-23 12:05 PM No

19668 Bug report Closed High Layers loaded from Browser are unusable 2018-08-22 12:14 PM No

19668 Bug report Closed High Layers loaded from Browser are unusable 2018-08-22 12:14 PM No

19666 Bug report Closed High Can't Select Shape File Polygon in New Project 2018-08-22 02:39 AM No

19666 Bug report Closed High Can't Select Shape File Polygon in New Project 2018-08-22 02:39 AM No

19655 Bug report Closed Normal GDAL tools - path not properly escaped 2018-08-21 11:36 AM No

19655 Bug report Closed Normal GDAL tools - path not properly escaped 2018-08-21 11:36 AM No

19653 Bug report Closed Normal Snapping Toolbar missing from View > Toolbars menu 2018-10-17 02:56 PM No

19653 Bug report Closed Normal Snapping Toolbar missing from View > Toolbars menu 2018-10-17 02:56 PM No

19651 Bug report Closed High Style loading issue Alessandro 

Pasotti

2018-08-23 11:06 AM Yes

19651 Bug report Closed High Style loading issue Alessandro 

Pasotti

2018-08-23 11:06 AM Yes

19643 Bug report Closed Normal Bug while modifying name of the project in the Project Properties | General dialog Alessandro 

Pasotti

2018-08-21 11:38 AM No

19643 Bug report Closed Normal Bug while modifying name of the project in the Project Properties | General dialog Alessandro 

Pasotti

2018-08-21 11:38 AM No

19638 Bug report Closed Normal CSV: numeric header gets a trailing underscore + 1 2018-08-29 11:38 AM Yes

19638 Bug report Closed Normal CSV: numeric header gets a trailing underscore + 1 2018-08-29 11:38 AM Yes

19637 Bug report Closed High temporary layers with a name get dropped into bin-directory 2018-08-21 11:35 AM No

19637 Bug report Closed High temporary layers with a name get dropped into bin-directory 2018-08-21 11:35 AM No

19625 Bug report Closed High OGR PBF dataset crashes QGIS 2018-08-15 10:37 AM No

19625 Bug report Closed High OGR PBF dataset crashes QGIS 2018-08-15 10:37 AM No

19617 Bug report Closed Normal Check validity algorithm returns empty reason in attribute table Alessandro 

Pasotti

2018-09-20 12:07 PM No

19617 Bug report Closed Normal Check validity algorithm returns empty reason in attribute table Alessandro 

Pasotti

2018-09-20 12:07 PM No

19611 Bug report Closed Normal Cannot save selected features back to the same GeoPackage Alessandro 

Pasotti

2018-08-22 10:13 AM Yes

19611 Bug report Closed Normal Cannot save selected features back to the same GeoPackage Alessandro 

Pasotti

2018-08-22 10:13 AM Yes

19599 Bug report Closed High locator bar crashes QGIS 3.2.1 GNU / Linux Mint 19 2018-08-15 12:06 PM No

19599 Bug report Closed High locator bar crashes QGIS 3.2.1 GNU / Linux Mint 19 2018-08-15 12:06 PM No

19597 Bug report Closed Normal OGR: "WARNING Cannot open <file>" when they seem to open fine? 2018-08-16 12:17 AM Yes

19597 Bug report Closed Normal OGR: "WARNING Cannot open <file>" when they seem to open fine? 2018-08-16 12:17 AM Yes

19591 Bug report Closed Normal Mesh layer transparency Peter Petrik 2018-09-14 02:03 PM No

19591 Bug report Closed Normal Mesh layer transparency Peter Petrik 2018-09-14 02:03 PM No

19590 Bug report Closed Normal Not possible to set MDAL layer CRS Peter Petrik 2018-09-25 02:06 PM No

19590 Bug report Closed Normal Not possible to set MDAL layer CRS Peter Petrik 2018-09-25 02:06 PM No

19582 Bug report Closed High QGIS crashes when click on "Plugins" in "Manage & Install Plugins" Borys Jurgiel 2018-11-08 02:04 PM No

19582 Bug report Closed High QGIS crashes when click on "Plugins" in "Manage & Install Plugins" Borys Jurgiel 2018-11-08 02:04 PM No

19578 Bug report Closed Normal MSSQL: Setting geometry type to "Polygon" makes layer unselectable 2018-08-12 12:02 PM No

19578 Bug report Closed Normal MSSQL: Setting geometry type to "Polygon" makes layer unselectable 2018-08-12 12:02 PM No

19570 Bug report Closed Normal Raster terrain analysis Relief Crashes QGIS 2018-08-10 09:57 PM No

19570 Bug report Closed Normal Raster terrain analysis Relief Crashes QGIS 2018-08-10 09:57 PM No

19566 Bug report Closed High Problem of printing a layout (map composer) 2018-08-29 11:37 AM No

19566 Bug report Closed High Problem of printing a layout (map composer) 2018-08-29 11:37 AM No

19552 Bug report Closed Normal QGIS 3.2.1 - Print Layout with Atlas - first tile exported is overwritten with next tile 2018-08-14 12:14 PM No

19552 Bug report Closed Normal QGIS 3.2.1 - Print Layout with Atlas - first tile exported is overwritten with next tile 2018-08-14 12:14 PM No

19544 Bug report Closed High QGIS 3.2.1-1 crashes on OS X after severe zooming in 2018-11-17 06:22 PM No

19544 Bug report Closed High QGIS 3.2.1-1 crashes on OS X after severe zooming in 2018-11-17 06:22 PM No

19542 Bug report Closed Normal qgis-3.2.1 fails to build without webkit 2018-08-12 09:28 PM No

19542 Bug report Closed Normal qgis-3.2.1 fails to build without webkit 2018-08-12 09:28 PM No

19524 Bug report Closed High [macOS] Map canvas with wrong size on QGIS 3.2.1 start up 2018-10-31 02:49 AM No

19524 Bug report Closed High [macOS] Map canvas with wrong size on QGIS 3.2.1 start up 2018-10-31 02:49 AM No

19484 Bug report Closed High Move label tool doesn't work with rule based labels 2018-12-28 03:10 PM No

19484 Bug report Closed High Move label tool doesn't work with rule based labels 2018-12-28 03:10 PM No

19469 Bug report Closed Normal [Processing] "Extract by attribute" algorithm allows an optional value as parameter 2018-08-29 09:10 PM No

19469 Bug report Closed Normal [Processing] "Extract by attribute" algorithm allows an optional value as parameter 2018-08-29 09:10 PM No

19459 Bug report Closed High Error on delimited text layer import in DB Manager 2018-08-05 04:48 PM No

19459 Bug report Closed High Error on delimited text layer import in DB Manager 2018-08-05 04:48 PM No

19455 Bug report Closed Normal Add MSSQL layer to canvas crashes QGIS3.2 2018-10-09 01:02 PM No

19455 Bug report Closed Normal Add MSSQL layer to canvas crashes QGIS3.2 2018-10-09 01:02 PM No

19454 Bug report Closed Normal r.info -> make use of Processiong output dir 2018-11-21 01:01 PM No
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19454 Bug report Closed Normal r.info -> make use of Processiong output dir 2018-11-21 01:01 PM No

19447 Bug report Closed Normal QGIS 3.0.3 froze when deleting a section from a report 2018-08-13 10:36 AM No

19447 Bug report Closed Normal QGIS 3.0.3 froze when deleting a section from a report 2018-08-13 10:36 AM No

19444 Bug report Closed Normal QGIS 3.2.0 crash while intersecting vector layers 2018-07-20 07:55 AM No

19444 Bug report Closed Normal QGIS 3.2.0 crash while intersecting vector layers 2018-07-20 07:55 AM No

19441 Bug report Closed Normal Layers with 80+ rule-based symbology do not render Alessandro 

Pasotti

2018-08-21 04:39 AM Yes

19441 Bug report Closed Normal Layers with 80+ rule-based symbology do not render Alessandro 

Pasotti

2018-08-21 04:39 AM Yes

19433 Bug report Closed Normal "List of contour levels" field in GRASS r.contour is mandatory, shouldn't be Giovanni 

Manghi

2018-10-04 01:01 AM No

19433 Bug report Closed Normal "List of contour levels" field in GRASS r.contour is mandatory, shouldn't be Giovanni 

Manghi

2018-10-04 01:01 AM No

19423 Bug report Closed Normal software crashed unexpectedly - It keeps happening each time 2018-07-16 03:44 AM No

19423 Bug report Closed Normal software crashed unexpectedly - It keeps happening each time 2018-07-16 03:44 AM No

19410 Bug report Closed High Unable to remove Custom Auxiliary Field Paul Blottiere 2018-12-28 02:59 PM No

19410 Bug report Closed High Unable to remove Custom Auxiliary Field Paul Blottiere 2018-12-28 02:59 PM No

19376 Bug report Closed Normal If a project filename contains periods, the filename is truncated at the first period when displayed in the main window's 

titlebar.

2018-08-23 08:46 PM No

19376 Bug report Closed Normal If a project filename contains periods, the filename is truncated at the first period when displayed in the main window's 

titlebar.

2018-08-23 08:46 PM No

19329 Bug report Closed Normal gdalcalc raster calculator gives QgsProcessingException (invalidRasterError) when used in a model 2018-07-11 03:24 PM Yes

19329 Bug report Closed Normal gdalcalc raster calculator gives QgsProcessingException (invalidRasterError) when used in a model 2018-07-11 03:24 PM Yes

19327 Bug report Closed High problems with network paths in inputs for GDAL Processing tools 2018-12-27 09:45 AM No

19327 Bug report Closed High problems with network paths in inputs for GDAL Processing tools 2018-12-27 09:45 AM No

19321 Bug report Closed Normal Map Tips on Mac doesn't display the content correctly 2018-10-31 10:18 AM No

19321 Bug report Closed Normal Map Tips on Mac doesn't display the content correctly 2018-10-31 10:18 AM No

19302 Bug report Closed High [processing] Modeler and Raster Calculator fail to calc pablotcarreira - 2018-09-04 08:07 PM Yes

19302 Bug report Closed High [processing] Modeler and Raster Calculator fail to calc pablotcarreira - 2018-09-04 08:07 PM Yes

19301 Bug report Closed Normal Processing misinterprets windows paths in history 2018-07-04 08:04 AM Yes

19301 Bug report Closed Normal Processing misinterprets windows paths in history 2018-07-04 08:04 AM Yes

19298 Bug report Closed Normal 'Order by expression' can't save to shapefile 2018-08-29 05:18 PM No

19298 Bug report Closed Normal 'Order by expression' can't save to shapefile 2018-08-29 05:18 PM No

19287 Bug report Closed Normal Crash while zooming with multiple rasters 2018-08-16 10:26 AM No

19287 Bug report Closed Normal Crash while zooming with multiple rasters 2018-08-16 10:26 AM No

19283 Bug report Closed High field calculator in not able to add a new field 2018-07-15 11:35 PM Yes

19283 Bug report Closed High field calculator in not able to add a new field 2018-07-15 11:35 PM Yes

19272 Bug report Closed High MSSQL Zooming Crash 2018-11-09 02:07 AM No

19272 Bug report Closed High MSSQL Zooming Crash 2018-11-09 02:07 AM No

19260 Bug report Closed Normal [Digitizing] The "Enable snapping on invisible features" option is always unchecked 2018-09-24 11:40 AM No

19260 Bug report Closed Normal [Digitizing] The "Enable snapping on invisible features" option is always unchecked 2018-09-24 11:40 AM No

19254 Bug report Closed Normal GRASS integration failures 2018-11-11 03:26 AM No

19254 Bug report Closed Normal GRASS integration failures 2018-11-11 03:26 AM No

19239 Bug report Closed Normal Plugin author email visible via plugin manager after install despite assurances in the cookbook Borys Jurgiel 2018-06-28 05:53 PM No

19239 Bug report Closed Normal Plugin author email visible via plugin manager after install despite assurances in the cookbook Borys Jurgiel 2018-06-28 05:53 PM No

19205 Bug report Closed Normal SAGA -> Terrain Analysis - Profiles -> Cross profiles gets a float where an integer is required 2018-06-18 10:39 AM No

19205 Bug report Closed Normal SAGA -> Terrain Analysis - Profiles -> Cross profiles gets a float where an integer is required 2018-06-18 10:39 AM No

19180 Bug report Closed Normal Treating UUID like text 2018-09-19 01:20 PM No

19180 Bug report Closed Normal Treating UUID like text 2018-09-19 01:20 PM No

19168 Bug report Closed Normal qGIS 3.0.3 sudden crash 2018-07-20 09:01 AM No

19168 Bug report Closed Normal qGIS 3.0.3 sudden crash 2018-07-20 09:01 AM No

19162 Bug report Closed Normal [Processing] GDAL translate sould not cast datatype by default 2018-09-25 02:13 AM No

19162 Bug report Closed Normal [Processing] GDAL translate sould not cast datatype by default 2018-09-25 02:13 AM No

19160 Bug report Closed Normal qgis3 src/plugins/grass/qgsgrass* failed to build with qt 5.11 2018-06-11 12:03 PM Yes

19160 Bug report Closed Normal qgis3 src/plugins/grass/qgsgrass* failed to build with qt 5.11 2018-06-11 12:03 PM Yes

19156 Bug report Closed Normal Move Label and Diagram button not working 2018-06-13 10:01 AM No

19156 Bug report Closed Normal Move Label and Diagram button not working 2018-06-13 10:01 AM No

19138 Bug report Closed Normal Hightlight vertex on map canvas in vertex table Denis Rouzaud 2018-06-08 01:42 PM No

19138 Bug report Closed Normal Hightlight vertex on map canvas in vertex table Denis Rouzaud 2018-06-08 01:42 PM No

19067 Bug report Closed High Unexpected error in the attribute table with the QGIS Union algorithm 2018-05-31 02:03 AM No

19067 Bug report Closed High Unexpected error in the attribute table with the QGIS Union algorithm 2018-05-31 02:03 AM No

19053 Bug report Closed Normal Crash while trying to georeference 2018-05-29 07:17 AM No

19053 Bug report Closed Normal Crash while trying to georeference 2018-05-29 07:17 AM No

19050 Bug report Closed Normal QGIS saves integer field when I create a new real field through field calculator (Update field works as intended) Alessandro 

Pasotti

2018-06-02 10:54 PM Yes

19050 Bug report Closed Normal QGIS saves integer field when I create a new real field through field calculator (Update field works as intended) Alessandro 

Pasotti

2018-06-02 10:54 PM Yes

19046 Bug report Closed High LTR-QGIS crashes after edit a Modell 2018-06-20 08:33 PM Yes

19046 Bug report Closed High LTR-QGIS crashes after edit a Modell 2018-06-20 08:33 PM Yes

19038 Bug report Closed Low Objects queried by QuickOSM are not automatically saved in project file and lost when re-starting QGIS (3) 2018-08-04 12:11 PM No

19038 Bug report Closed Low Objects queried by QuickOSM are not automatically saved in project file and lost when re-starting QGIS (3) 2018-08-04 12:11 PM No

19033 Bug report Closed Low Error report join attributes by location 2018-06-05 04:06 AM No

19033 Bug report Closed Low Error report join attributes by location 2018-06-05 04:06 AM No

18984 Bug report Closed Normal Processing  "Import vector into PostGIS database" can't change schema name 2019-01-11 12:08 AM No

18984 Bug report Closed Normal Processing  "Import vector into PostGIS database" can't change schema name 2019-01-11 12:08 AM No

18981 Bug report Closed High Save QLR crashes QGIS 3 Alessandro 

Pasotti

2018-06-07 09:55 AM Yes

18981 Bug report Closed High Save QLR crashes QGIS 3 Alessandro 

Pasotti

2018-06-07 09:55 AM Yes

18977 Bug report Closed Normal Problem changing the proyection of point shapefile 2018-05-22 04:01 AM No
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18977 Bug report Closed Normal Problem changing the proyection of point shapefile 2018-05-22 04:01 AM No

18969 Bug report Closed Normal syncDB() and syncDatabase() fail to import WKTs from esri_extra.wkt and cubewerx_extra.wkt 2018-05-19 10:44 PM Yes

18969 Bug report Closed Normal syncDB() and syncDatabase() fail to import WKTs from esri_extra.wkt and cubewerx_extra.wkt 2018-05-19 10:44 PM Yes

18963 Bug report Closed High Can not write a decimal in a real field of a layer spatialite Alessandro 

Pasotti

2018-06-12 08:54 AM No

18963 Bug report Closed High Can not write a decimal in a real field of a layer spatialite Alessandro 

Pasotti

2018-06-12 08:54 AM No

18958 Bug report Closed Normal Weird character at the end of Project --> Open from --> PostgreSQL menu title 2018-10-02 06:04 AM No

18958 Bug report Closed Normal Weird character at the end of Project --> Open from --> PostgreSQL menu title 2018-10-02 06:04 AM No

18953 Bug report Closed Normal Crash after qgis close 2018-05-15 10:26 AM No

18953 Bug report Closed Normal Crash after qgis close 2018-05-15 10:26 AM No

18941 Bug report Closed Normal Can't edit GeoPackage using SQL through DBManager 2018-07-05 11:00 PM No

18941 Bug report Closed Normal Can't edit GeoPackage using SQL through DBManager 2018-07-05 11:00 PM No

18932 Bug report Closed Normal Save as default style for raster reset symbology 2019-01-11 11:37 AM No

18932 Bug report Closed Normal Save as default style for raster reset symbology 2019-01-11 11:37 AM No

18923 Bug report Closed Normal GDAL/OGR Convert Format, persistent/unwanted default output format 2018-06-04 02:01 AM No

18923 Bug report Closed Normal GDAL/OGR Convert Format, persistent/unwanted default output format 2018-06-04 02:01 AM No

18916 Bug report Closed High QGIS crashes with no geometry tables 2018-05-07 10:45 AM No

18916 Bug report Closed High QGIS crashes with no geometry tables 2018-05-07 10:45 AM No

18915 Bug report Closed Normal pyQGIS -    new_point.transform(tr) Exception: unknown Denis Rouzaud 2018-09-20 03:40 AM No

18915 Bug report Closed Normal pyQGIS -    new_point.transform(tr) Exception: unknown Denis Rouzaud 2018-09-20 03:40 AM No

18913 Bug report Closed Normal Union tool gives completly unpredictive results 2018-05-06 12:40 PM No

18913 Bug report Closed Normal Union tool gives completly unpredictive results 2018-05-06 12:40 PM No

18899 Bug report Closed Normal Sorting an attribute table with Actions enabled hides the values in the first column with the Action combo box Julien Cabieces 2019-01-10 11:10 AM No

18899 Bug report Closed Normal Sorting an attribute table with Actions enabled hides the values in the first column with the Action combo box Julien Cabieces 2019-01-10 11:10 AM No

18898 Bug report Closed Normal Problem using processing dissolve from pyqgis 2018-05-06 08:56 AM No

18898 Bug report Closed Normal Problem using processing dissolve from pyqgis 2018-05-06 08:56 AM No

18895 Bug report Closed Normal Translate (convert format) ignores nodata value of zero 2018-05-03 04:05 AM No

18895 Bug report Closed Normal Translate (convert format) ignores nodata value of zero 2018-05-03 04:05 AM No

18882 Bug report Closed Normal Attempting to add layer using site-wide WFS get capabilities URL in QGIS 3 errors out Even Rouault 2018-05-23 03:23 PM No

18882 Bug report Closed Normal Attempting to add layer using site-wide WFS get capabilities URL in QGIS 3 errors out Even Rouault 2018-05-23 03:23 PM No

18877 Bug report Closed High Maximum recursion depth exceeded after adding a model or script to the Processing algorithm list (since 2.18.18!) René-Luc 

ReLuc

2018-06-20 08:35 PM No

18877 Bug report Closed High Maximum recursion depth exceeded after adding a model or script to the Processing algorithm list (since 2.18.18!) René-Luc 

ReLuc

2018-06-20 08:35 PM No

18807 Bug report Closed High Enabling/disabling algorithm providers as well as creating/removing preconfigured algorithms causes an infinite loop 

(regression after c83261395476b62f6)

René-Luc 

ReLuc

2018-05-17 04:34 PM No

18807 Bug report Closed High Enabling/disabling algorithm providers as well as creating/removing preconfigured algorithms causes an infinite loop 

(regression after c83261395476b62f6)

René-Luc 

ReLuc

2018-05-17 04:34 PM No

18802 Bug report Closed Normal Mesh layer with unknown CRS Peter Petrik 2018-09-25 02:06 PM No

18802 Bug report Closed Normal Mesh layer with unknown CRS Peter Petrik 2018-09-25 02:06 PM No

18795 Bug report Closed Normal Crashed on saving a project 2018-09-04 12:10 PM No

18795 Bug report Closed Normal Crashed on saving a project 2018-09-04 12:10 PM No

18746 Bug report Closed Normal QGIS 3 crashed 2018-07-20 09:04 AM No

18746 Bug report Closed Normal QGIS 3 crashed 2018-07-20 09:04 AM No

18740 Bug report Closed High is a WFS layer is large enough then identifying a feature in QGIS with the "auto open  form" option active leads to memory 

leak/crashes

Even Rouault 2018-05-23 11:41 AM No

18740 Bug report Closed High is a WFS layer is large enough then identifying a feature in QGIS with the "auto open  form" option active leads to memory 

leak/crashes

Even Rouault 2018-05-23 11:41 AM No

18727 Bug report Closed Normal Save As kml crashes with sybology 2018-04-16 07:10 AM No

18727 Bug report Closed Normal Save As kml crashes with sybology 2018-04-16 07:10 AM No

18724 Bug report Closed Normal GRASS 7 r.viewshed fails 2018-04-15 11:12 AM No

18724 Bug report Closed Normal GRASS 7 r.viewshed fails 2018-04-15 11:12 AM No

18722 Bug report Closed Normal crash when i trying to load a wfs layer 2018-07-24 08:25 AM Yes

18722 Bug report Closed Normal crash when i trying to load a wfs layer 2018-07-24 08:25 AM Yes

18710 Bug report Closed Normal SAGA Kriging defaults wrong and missing options Nicole Morgan 2018-06-04 05:57 AM No

18710 Bug report Closed Normal SAGA Kriging defaults wrong and missing options Nicole Morgan 2018-06-04 05:57 AM No

18703 Bug report Closed Normal QGIS will not complete rendering zoomed-out labels 2018-04-11 09:03 PM No

18703 Bug report Closed Normal QGIS will not complete rendering zoomed-out labels 2018-04-11 09:03 PM No

18698 Bug report Closed Normal qgsgml.cpp and gdal 2.4.4 incompatibility? (DEBUG build) 2018-04-11 11:47 PM No

18698 Bug report Closed Normal qgsgml.cpp and gdal 2.4.4 incompatibility? (DEBUG build) 2018-04-11 11:47 PM No

18696 Bug report Closed Normal libdxfrw doesn’t honor the "DEBUG" flag Jürgen Fischer 2018-04-11 11:47 PM No

18696 Bug report Closed Normal libdxfrw doesn’t honor the "DEBUG" flag Jürgen Fischer 2018-04-11 11:47 PM No

18689 Bug report Closed Normal QGIS 3.0.1 crashes when zoomed to 1:2,721 2018-07-20 09:06 AM No

18689 Bug report Closed Normal QGIS 3.0.1 crashes when zoomed to 1:2,721 2018-07-20 09:06 AM No

18679 Bug report Closed High Cannot insert decimal separator to field Alessandro 

Pasotti

2018-06-12 08:53 AM No

18679 Bug report Closed High Cannot insert decimal separator to field Alessandro 

Pasotti

2018-06-12 08:53 AM No

18678 Bug report Closed Normal System crash/logout with temp layer in Layers panel 2018-12-27 08:21 PM No

18678 Bug report Closed Normal System crash/logout with temp layer in Layers panel 2018-12-27 08:21 PM No

18669 Bug report Closed Normal Crashed after changing the UI theme 2018-12-27 10:14 AM No

18669 Bug report Closed Normal Crashed after changing the UI theme 2018-12-27 10:14 AM No

18648 Bug report Closed Normal QGIS 3.0 crash checking statistics 2018-07-20 09:05 AM No

18648 Bug report Closed Normal QGIS 3.0 crash checking statistics 2018-07-20 09:05 AM No

18642 Bug report Closed Normal Geometry tools Check validity  unable to distinguish between different memory layers 2018-06-05 04:08 AM No

18642 Bug report Closed Normal Geometry tools Check validity  unable to distinguish between different memory layers 2018-06-05 04:08 AM No

18622 Bug report Closed Normal Mouse pointer displacement 2018-10-31 10:30 AM No

18622 Bug report Closed Normal Mouse pointer displacement 2018-10-31 10:30 AM No

18620 Bug report Closed High Layer rendering order broken in QGIS 3x Alessandro 

Pasotti

2018-04-05 02:41 PM Yes
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18620 Bug report Closed High Layer rendering order broken in QGIS 3x Alessandro 

Pasotti

2018-04-05 02:41 PM Yes

18608 Bug report Closed Normal Layer tree embedded widgets do not show up unless you move layer Alessandro 

Pasotti

2018-10-08 09:06 AM Yes

18608 Bug report Closed Normal Layer tree embedded widgets do not show up unless you move layer Alessandro 

Pasotti

2018-10-08 09:06 AM Yes

18600 Bug report Closed Normal QGIS3: can't cancel ogr2ogr Victor Olaya 2018-06-04 02:01 AM No

18600 Bug report Closed Normal QGIS3: can't cancel ogr2ogr Victor Olaya 2018-06-04 02:01 AM No

18576 Bug report Closed Normal dwg import fails if filename contains special characters and spaces Jürgen Fischer 2018-08-07 09:34 AM No

18576 Bug report Closed Normal dwg import fails if filename contains special characters and spaces Jürgen Fischer 2018-08-07 09:34 AM No

18558 Bug report Closed High QGIS crash with SQL Server layer 2018-09-10 05:20 PM No

18558 Bug report Closed High QGIS crash with SQL Server layer 2018-09-10 05:20 PM No

18557 Bug report Closed Normal Layout Setup of Page not working 2018-08-13 02:27 AM No

18557 Bug report Closed Normal Layout Setup of Page not working 2018-08-13 02:27 AM No

18556 Bug report Closed High [Interpolation Algorithm] Missing the option X and Y cellsize 2018-12-30 03:00 PM No

18556 Bug report Closed High [Interpolation Algorithm] Missing the option X and Y cellsize 2018-12-30 03:00 PM No

18553 Bug report Closed Normal Advanced Digitizing Tool - Crash on Rotate Feature 2018-03-27 09:07 AM No

18553 Bug report Closed Normal Advanced Digitizing Tool - Crash on Rotate Feature 2018-03-27 09:07 AM No

18550 Bug report Closed Normal Topology Rule Settings Dialog UI Issues 2018-03-27 04:52 PM No

18550 Bug report Closed Normal Topology Rule Settings Dialog UI Issues 2018-03-27 04:52 PM No

18539 Bug report Closed Normal contour dialog box returns invalid path to GDAL command on windows Victor Olaya 2018-06-04 04:14 AM No

18539 Bug report Closed Normal contour dialog box returns invalid path to GDAL command on windows Victor Olaya 2018-06-04 04:14 AM No

18530 Bug report Closed Normal Removing project item from Welcome screen crashes QGIS 2018-03-26 09:54 AM No

18530 Bug report Closed Normal Removing project item from Welcome screen crashes QGIS 2018-03-26 09:54 AM No

18499 Bug report Closed Normal "Snapping Toolbar" missing from View > Toolbars 2018-09-24 10:27 AM No

18499 Bug report Closed Normal "Snapping Toolbar" missing from View > Toolbars 2018-09-24 10:27 AM No

18453 Bug report Closed Normal QGIS crashes when I remove from layer panel multiple layers with svg markers 2018-08-16 02:17 PM No

18453 Bug report Closed Normal QGIS crashes when I remove from layer panel multiple layers with svg markers 2018-08-16 02:17 PM No

18422 Bug report Closed Normal Data Source Manager window not vertically-resizable 2018-12-31 11:01 PM No

18422 Bug report Closed Normal Data Source Manager window not vertically-resizable 2018-12-31 11:01 PM No

18420 Bug report Closed High Excessive, erratic memory usage Nyall Dawson 2018-11-08 04:58 PM Yes

18420 Bug report Closed High Excessive, erratic memory usage Nyall Dawson 2018-11-08 04:58 PM Yes

18403 Bug report Closed High QGIS 3 crashes when assigning SLD style files to Mapinfo Tab files, while 2.18 assigns same files correctly without issue 2018-11-12 09:38 AM No

18403 Bug report Closed High QGIS 3 crashes when assigning SLD style files to Mapinfo Tab files, while 2.18 assigns same files correctly without issue 2018-11-12 09:38 AM No

18378 Bug report Closed High Cursor icons on OSX 2018-12-28 05:17 PM No

18378 Bug report Closed High Cursor icons on OSX 2018-12-28 05:17 PM No

18375 Bug report Closed High DB Manager Topoviewer cant load Postgis topology schema 2018-03-07 11:35 PM No

18375 Bug report Closed High DB Manager Topoviewer cant load Postgis topology schema 2018-03-07 11:35 PM No

18360 Bug report Closed Normal Problems download of sample data from windows installer 2018-12-31 08:49 PM No

18360 Bug report Closed Normal Problems download of sample data from windows installer 2018-12-31 08:49 PM No

18358 Bug report Closed Normal Documentation error for lang !=en Richard 

Duivenvoorde

2018-03-07 07:57 AM No

18358 Bug report Closed Normal Documentation error for lang !=en Richard 

Duivenvoorde

2018-03-07 07:57 AM No

18352 Bug report Closed High DB Manager is not showing the result after a SQL query Paul Blottiere 2018-03-09 11:46 AM Yes

18352 Bug report Closed High DB Manager is not showing the result after a SQL query Paul Blottiere 2018-03-09 11:46 AM Yes

18337 Bug report Closed Normal Absolute paths stored in Qgis 3.0 project file for GDAL layers 2018-08-16 02:14 PM Yes

18337 Bug report Closed Normal Absolute paths stored in Qgis 3.0 project file for GDAL layers 2018-08-16 02:14 PM Yes

18335 Bug report Closed High Invalid file names for outputs in Processing models Victor Olaya 2018-03-05 12:11 PM No

18335 Bug report Closed High Invalid file names for outputs in Processing models Victor Olaya 2018-03-05 12:11 PM No

18334 Bug report Closed Normal German Translation QGIS 

Translation 

Team

2018-09-24 03:14 AM No

18334 Bug report Closed Normal German Translation QGIS 

Translation 

Team

2018-09-24 03:14 AM No

18327 Bug report Closed Low Selecting "arrow" as line style crash QGIS in custom projection 2018-03-06 12:29 AM Yes

18327 Bug report Closed Low Selecting "arrow" as line style crash QGIS in custom projection 2018-03-06 12:29 AM Yes

18325 Bug report Closed High Feature form is not remmebering last configuration 2018-04-19 01:58 PM No

18325 Bug report Closed High Feature form is not remmebering last configuration 2018-04-19 01:58 PM No

18315 Bug report Closed High Select by location: selection in the wrong layer Victor Olaya 2018-05-16 02:46 PM Yes

18315 Bug report Closed High Select by location: selection in the wrong layer Victor Olaya 2018-05-16 02:46 PM Yes

18308 Bug report Closed Normal Invalid WFS-Transaction Update request 2018-09-21 11:00 PM No

18308 Bug report Closed Normal Invalid WFS-Transaction Update request 2018-09-21 11:00 PM No

18303 Bug report Closed Normal Raster Calculator "Output Layer" opens, rather than saves 2018-03-02 09:03 AM No

18303 Bug report Closed Normal Raster Calculator "Output Layer" opens, rather than saves 2018-03-02 09:03 AM No

18297 Bug report Closed Normal Minimum value not accepted in range widget with "allow null" 2018-03-03 09:24 AM No

18297 Bug report Closed Normal Minimum value not accepted in range widget with "allow null" 2018-03-03 09:24 AM No

18294 Bug report Closed High Processing Throws Exception when dialog is open while starting new project Victor Olaya 2018-03-01 10:34 PM No

18294 Bug report Closed High Processing Throws Exception when dialog is open while starting new project Victor Olaya 2018-03-01 10:34 PM No

18293 Bug report Closed High New node tool is really slow to index for big project with many editable layers 2018-10-23 11:37 AM No

18293 Bug report Closed High New node tool is really slow to index for big project with many editable layers 2018-10-23 11:37 AM No

18291 Bug report Closed High [Layout] Exporting a layout with a special character in its name changes the output file name 2018-03-06 11:55 AM No

18291 Bug report Closed High [Layout] Exporting a layout with a special character in its name changes the output file name 2018-03-06 11:55 AM No

18289 Bug report Closed High GIS 3 Atlas not work with oracle spatial layer 2018-03-06 09:55 AM No

18289 Bug report Closed High GIS 3 Atlas not work with oracle spatial layer 2018-03-06 09:55 AM No

18288 Bug report Closed Normal [Layout] Item's properties no longer shows item's name at the top of the widget 2018-03-02 09:03 AM No

18288 Bug report Closed Normal [Layout] Item's properties no longer shows item's name at the top of the widget 2018-03-02 09:03 AM No

18283 Bug report Closed High serious regression: labelling's parallel placement leads to endless label rendering Nyall Dawson 2018-03-06 11:54 AM No
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18283 Bug report Closed High serious regression: labelling's parallel placement leads to endless label rendering Nyall Dawson 2018-03-06 11:54 AM No

18282 Bug report Closed High Style Manager - Impossible to work with non-Latin characters (tag or symbol names) Alessandro 

Pasotti

2018-06-14 09:49 AM Yes

18282 Bug report Closed High Style Manager - Impossible to work with non-Latin characters (tag or symbol names) Alessandro 

Pasotti

2018-06-14 09:49 AM Yes

18281 Bug report Closed Low [UI] Wrong window title for 3D configuration window 2018-03-03 09:24 AM No

18281 Bug report Closed Low [UI] Wrong window title for 3D configuration window 2018-03-03 09:24 AM No

18279 Bug report Closed Low [UI] Empty space in Properties window > Sources 2018-03-01 04:23 PM No

18279 Bug report Closed Low [UI] Empty space in Properties window > Sources 2018-03-01 04:23 PM No

18278 Bug report Closed Normal QGIS3: selected features only greyed out Victor Olaya 2018-03-01 10:49 AM No

18278 Bug report Closed Normal QGIS3: selected features only greyed out Victor Olaya 2018-03-01 10:49 AM No

18269 Bug report Closed High Layout legend items do not respect reference point when autosizing Nyall Dawson 2018-07-06 01:23 PM No

18269 Bug report Closed High Layout legend items do not respect reference point when autosizing Nyall Dawson 2018-07-06 01:23 PM No

18266 Bug report Closed Normal Browser panel does not show same folder icons in two different user profiles 2018-10-04 12:25 AM No

18266 Bug report Closed Normal Browser panel does not show same folder icons in two different user profiles 2018-10-04 12:25 AM No

18263 Bug report Closed High Interpolation algorithms not running in Graphical Modeler in QGIS 3.0 Nyall Dawson 2018-03-06 11:55 AM No

18263 Bug report Closed High Interpolation algorithms not running in Graphical Modeler in QGIS 3.0 Nyall Dawson 2018-03-06 11:55 AM No

18262 Bug report Closed Normal GRASS shell does not receive QGIS toolbars shortcut letters Radim Blazek 2018-02-28 02:13 PM No

18262 Bug report Closed Normal GRASS shell does not receive QGIS toolbars shortcut letters Radim Blazek 2018-02-28 02:13 PM No

18252 Bug report Closed Normal Shape digitize tools do not show rubberband fill color when drawing polygons 2018-09-25 11:42 AM No

18252 Bug report Closed Normal Shape digitize tools do not show rubberband fill color when drawing polygons 2018-09-25 11:42 AM No

18249 Bug report Closed Normal QGIS Server 2.18 much slower than 2.14 (at least for WFS getfeature requests) René-Luc 

ReLuc

2018-04-20 04:47 PM Yes

18249 Bug report Closed Normal QGIS Server 2.18 much slower than 2.14 (at least for WFS getfeature requests) René-Luc 

ReLuc

2018-04-20 04:47 PM Yes

18248 Bug report Closed Normal Spelling mistake in Clip Raster by Mask tool Giovanni 

Manghi

2018-03-01 10:51 AM No

18248 Bug report Closed Normal Spelling mistake in Clip Raster by Mask tool Giovanni 

Manghi

2018-03-01 10:51 AM No

18247 Bug report Closed High qgis-server - Problem with id field for WFS request Marco 

Hugentobler

2018-08-23 01:04 AM Yes

18247 Bug report Closed High qgis-server - Problem with id field for WFS request Marco 

Hugentobler

2018-08-23 01:04 AM Yes

18244 Bug report Closed High DB Manager: "Update SQL layer" error 2019-01-02 09:05 AM No

18244 Bug report Closed High DB Manager: "Update SQL layer" error 2019-01-02 09:05 AM No

18238 Bug report Closed Normal Python error:  couldn't load plugin 'processing' (python error) Victor Olaya 2018-03-01 09:08 AM No

18238 Bug report Closed Normal Python error:  couldn't load plugin 'processing' (python error) Victor Olaya 2018-03-01 09:08 AM No

18236 Bug report Closed Normal Batch processing issues Victor Olaya 2018-03-01 11:12 AM No

18236 Bug report Closed Normal Batch processing issues Victor Olaya 2018-03-01 11:12 AM No

18234 Bug report Closed Normal Esri Personal GeoDatabase (*.mdb file) 2018-06-18 06:27 AM No

18234 Bug report Closed Normal Esri Personal GeoDatabase (*.mdb file) 2018-06-18 06:27 AM No

18231 Bug report Closed High DB Manager - PostgreSQL and Converted Config Seg error 2018-11-11 01:29 PM No

18231 Bug report Closed High DB Manager - PostgreSQL and Converted Config Seg error 2018-11-11 01:29 PM No

18230 Bug report Closed High QGIS server 3.0 : service configuration error (service unknown or unsupported) Alessandro 

Pasotti

2018-11-27 11:02 PM Yes

18230 Bug report Closed High QGIS server 3.0 : service configuration error (service unknown or unsupported) Alessandro 

Pasotti

2018-11-27 11:02 PM Yes

18215 Bug report Closed Normal Processing: problems outputting raster layers from a model as a "final result" Victor Olaya 2018-06-01 05:41 AM No

18215 Bug report Closed Normal Processing: problems outputting raster layers from a model as a "final result" Victor Olaya 2018-06-01 05:41 AM No

18213 Bug report Closed Low Processing modeler - undocked panes should be closed when the modeler is closed Victor Olaya 2018-03-01 12:32 PM No

18213 Bug report Closed Low Processing modeler - undocked panes should be closed when the modeler is closed Victor Olaya 2018-03-01 12:32 PM No

18211 Bug report Closed High QGIS 3: SAGA modules missing the SAGA icon Victor Olaya 2018-03-01 11:58 AM No

18211 Bug report Closed High QGIS 3: SAGA modules missing the SAGA icon Victor Olaya 2018-03-01 11:58 AM No

18206 Bug report Closed Normal Lost icon size setting 2018-02-25 05:19 PM No

18206 Bug report Closed Normal Lost icon size setting 2018-02-25 05:19 PM No

18203 Bug report Closed Normal "Build virtual raster" not localised QGIS 

Translation 

Team

2018-11-02 11:15 AM No

18203 Bug report Closed Normal "Build virtual raster" not localised QGIS 

Translation 

Team

2018-11-02 11:15 AM No

18194 Bug report Closed High QGIS3 Processing Graphical Modeler GUI is messed up on OSX Victor Olaya 2018-03-15 09:13 PM No

18194 Bug report Closed High QGIS3 Processing Graphical Modeler GUI is messed up on OSX Victor Olaya 2018-03-15 09:13 PM No

18192 Bug report Closed High vertex editor doesn't honour topological editing when moving a segment Martin Dobias 2018-11-21 01:52 PM No

18192 Bug report Closed High vertex editor doesn't honour topological editing when moving a segment Martin Dobias 2018-11-21 01:52 PM No

18190 Bug report Closed Normal vertex editor don't honour topological editing when used with a feature selection AND a node selection Martin Dobias 2018-11-21 02:58 PM No

18190 Bug report Closed Normal vertex editor don't honour topological editing when used with a feature selection AND a node selection Martin Dobias 2018-11-21 02:58 PM No

18188 Bug report Closed High Floating point spin box values cannot be changed when using localized QGIS Victor Olaya 2018-12-27 10:18 AM No

18188 Bug report Closed High Floating point spin box values cannot be changed when using localized QGIS Victor Olaya 2018-12-27 10:18 AM No

18187 Bug report Closed High  QGIS 3: SAGA "output extent" values are not in the right order Victor Olaya 2018-02-25 05:36 PM No

18187 Bug report Closed High  QGIS 3: SAGA "output extent" values are not in the right order Victor Olaya 2018-02-25 05:36 PM No

18132 Bug report Closed High Dpi resolution of images exported from composer is wrong 2018-04-15 10:42 PM Yes

18132 Bug report Closed High Dpi resolution of images exported from composer is wrong 2018-04-15 10:42 PM Yes

18114 Bug report Closed Low QGIS startup error when trying to start from icon pinned to taskbar (Windows 10 Pro) Jürgen Fischer 2018-02-15 09:15 PM No

18114 Bug report Closed Low QGIS startup error when trying to start from icon pinned to taskbar (Windows 10 Pro) Jürgen Fischer 2018-02-15 09:15 PM No

18111 Bug report Closed Normal Join attributes by location problem 2018-02-15 09:17 PM No

18111 Bug report Closed Normal Join attributes by location problem 2018-02-15 09:17 PM No

18107 Bug report Closed Normal "scrollwheel" far too sensitive on mac 2018-02-15 02:52 AM No

18107 Bug report Closed Normal "scrollwheel" far too sensitive on mac 2018-02-15 02:52 AM No

18088 Bug report Closed Normal QGIS 2 API Documentation: links to QT4 classes not found Denis Rouzaud 2018-02-21 05:53 PM No
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18088 Bug report Closed Normal QGIS 2 API Documentation: links to QT4 classes not found Denis Rouzaud 2018-02-21 05:53 PM No

18081 Bug report Closed Normal GDB recognition mixup 2018-06-01 02:44 PM No

18081 Bug report Closed Normal GDB recognition mixup 2018-06-01 02:44 PM No

18075 Bug report Closed Normal Checkbox options in drag and drop designer disappears when default value is not blank in QGIS 2.99 2018-03-05 02:13 AM No

18075 Bug report Closed Normal Checkbox options in drag and drop designer disappears when default value is not blank in QGIS 2.99 2018-03-05 02:13 AM No

18049 Bug report Closed Low no values in merge layers log 2018-02-21 09:19 PM No

18049 Bug report Closed Low no values in merge layers log 2018-02-21 09:19 PM No

18025 Bug report Closed High QGIS 2.18.16 crash on "save as" 2018-08-16 12:08 AM No

18025 Bug report Closed High QGIS 2.18.16 crash on "save as" 2018-08-16 12:08 AM No

18013 Bug report Closed Normal Incorrect GDAL parameters generated in Grid Interpolate tool (via menu or Processing) Giovanni 

Manghi

2018-02-21 09:21 PM No

18013 Bug report Closed Normal Incorrect GDAL parameters generated in Grid Interpolate tool (via menu or Processing) Giovanni 

Manghi

2018-02-21 09:21 PM No

17967 Bug report Closed Normal Browser: deleting raster in GeoPackage doesn't work Alessandro 

Pasotti

2018-09-20 10:26 AM Yes

17967 Bug report Closed Normal Browser: deleting raster in GeoPackage doesn't work Alessandro 

Pasotti

2018-09-20 10:26 AM Yes

17951 Bug report Closed High  QGIS Server lost (most of the times) the ability to cascade WFS layers Alessandro 

Pasotti

2018-06-03 08:38 PM No

17951 Bug report Closed High  QGIS Server lost (most of the times) the ability to cascade WFS layers Alessandro 

Pasotti

2018-06-03 08:38 PM No

17941 Bug report Closed High All geogcs names imported from GDAL/PROJ are wrongly set to "Imported from GDAL" 2018-02-21 09:45 PM Yes

17941 Bug report Closed High All geogcs names imported from GDAL/PROJ are wrongly set to "Imported from GDAL" 2018-02-21 09:45 PM Yes

17930 Bug report Closed High gdaldem does not respect output format Victor Olaya 2018-02-21 09:47 PM No

17930 Bug report Closed High gdaldem does not respect output format Victor Olaya 2018-02-21 09:47 PM No

17929 Bug report Closed Normal output file paths not quoted (m.cogo, v.out.vtk, ...) Victor Olaya 2018-02-21 09:47 PM No

17929 Bug report Closed Normal output file paths not quoted (m.cogo, v.out.vtk, ...) Victor Olaya 2018-02-21 09:47 PM No

17917 Bug report Closed Normal Globe plugin (globeplugin.dll) fails to load 2018-02-02 03:18 PM No

17917 Bug report Closed Normal Globe plugin (globeplugin.dll) fails to load 2018-02-02 03:18 PM No

17869 Bug report Closed Normal database check constraints on several fields can't be evaluated correctly on update in transaction mode Paul Blottiere 2018-02-21 09:51 PM No

17869 Bug report Closed Normal database check constraints on several fields can't be evaluated correctly on update in transaction mode Paul Blottiere 2018-02-21 09:51 PM No

17864 Bug report Closed Normal Graphical modeler doesn`t preserve utf 8 encoding Victor Olaya 2018-09-25 08:32 AM No

17864 Bug report Closed Normal Graphical modeler doesn`t preserve utf 8 encoding Victor Olaya 2018-09-25 08:32 AM No

17850 Bug report Closed High Grass v.segment from processing toolbox run with wrong parameter name Victor Olaya 2018-02-21 09:52 PM No

17850 Bug report Closed High Grass v.segment from processing toolbox run with wrong parameter name Victor Olaya 2018-02-21 09:52 PM No

17819 Bug report Closed Low Label unsizable at batch processes 2018-02-21 09:53 PM Yes

17819 Bug report Closed Low Label unsizable at batch processes 2018-02-21 09:53 PM Yes

17815 Bug report Closed Normal GRASS plugin tries to set method for r.in.wms twice, causing failure 2018-02-21 10:26 PM Yes

17815 Bug report Closed Normal GRASS plugin tries to set method for r.in.wms twice, causing failure 2018-02-21 10:26 PM Yes

17774 Bug report Closed Normal SSL error when launching QGIS 2018-02-22 10:59 AM No

17774 Bug report Closed Normal SSL error when launching QGIS 2018-02-22 10:59 AM No

17750 Bug report Closed Low Installing QGIS Server on Ubuntu/Debian 2018-02-19 02:40 PM No

17750 Bug report Closed Low Installing QGIS Server on Ubuntu/Debian 2018-02-19 02:40 PM No

17716 Bug report Closed Low Bleached pixels at right and bottom border - saving as image from composer 2018-01-03 10:15 PM No

17716 Bug report Closed Low Bleached pixels at right and bottom border - saving as image from composer 2018-01-03 10:15 PM No

17681 Bug report Closed High Negative values for age in expressions Sandro Santilli 2018-02-22 11:42 AM Yes

17681 Bug report Closed High Negative values for age in expressions Sandro Santilli 2018-02-22 11:42 AM Yes

17647 Bug report Closed Normal Offline editing; attribute changes only applied on first layer 2018-02-22 11:44 AM No

17647 Bug report Closed Normal Offline editing; attribute changes only applied on first layer 2018-02-22 11:44 AM No

17643 Bug report Closed High Circular string does not work Jürgen Fischer 2018-02-22 11:06 AM No

17643 Bug report Closed High Circular string does not work Jürgen Fischer 2018-02-22 11:06 AM No

17636 Bug report Closed High QGIS crashes when a layer is removed while loading the attribute table Alessandro 

Pasotti

2018-02-22 11:44 AM Yes

17636 Bug report Closed High QGIS crashes when a layer is removed while loading the attribute table Alessandro 

Pasotti

2018-02-22 11:44 AM Yes

17630 Bug report Closed Normal Annotations not showing in Composer on OSX 2018-06-04 01:26 AM No

17630 Bug report Closed Normal Annotations not showing in Composer on OSX 2018-06-04 01:26 AM No

17606 Bug report Closed High QGIS Server 2.14.19 WFS GetFeature Server Error 2018-11-08 11:51 AM No

17606 Bug report Closed High QGIS Server 2.14.19 WFS GetFeature Server Error 2018-11-08 11:51 AM No

17571 Bug report Closed Normal Geoprocessing with shapefile, with the z dimension, error 1005 with default use. 2018-06-01 06:59 AM No

17571 Bug report Closed Normal Geoprocessing with shapefile, with the z dimension, error 1005 with default use. 2018-06-01 06:59 AM No

17560 Bug report Closed Normal Attribute Table refresh issue: when there's only one row on attribute table, update buttons do not trigger table update. 2018-02-23 10:27 AM No

17560 Bug report Closed Normal Attribute Table refresh issue: when there's only one row on attribute table, update buttons do not trigger table update. 2018-02-23 10:27 AM No

17538 Bug report Closed High MYSQL Connection with wrong tables 2018-06-01 02:43 PM No

17538 Bug report Closed High MYSQL Connection with wrong tables 2018-06-01 02:43 PM No

17507 Bug report Closed High Unable to edit filtered GeoPackage layer Alessandro 

Pasotti

2018-01-04 11:17 PM Yes

17507 Bug report Closed High Unable to edit filtered GeoPackage layer Alessandro 

Pasotti

2018-01-04 11:17 PM Yes

17468 Bug report Closed High Processing: "export/add geometry columns" corrupts data Victor Olaya 2018-06-01 04:04 AM No

17468 Bug report Closed High Processing: "export/add geometry columns" corrupts data Victor Olaya 2018-06-01 04:04 AM No

17442 Bug report Closed High Categorized style issue using numeric fields with NULL values Alessandro 

Pasotti

2017-11-24 01:45 PM Yes

17442 Bug report Closed High Categorized style issue using numeric fields with NULL values Alessandro 

Pasotti

2017-11-24 01:45 PM Yes

17379 Bug report Closed High WMS layers not rendered in Composer - 2.18.14-16 Matthias Kuhn 2017-12-01 07:04 PM No

17379 Bug report Closed High WMS layers not rendered in Composer - 2.18.14-16 Matthias Kuhn 2017-12-01 07:04 PM No

17370 Bug report Closed Normal point parameter bug in processing batch process Victor Olaya 2018-06-01 07:00 AM No

17370 Bug report Closed Normal point parameter bug in processing batch process Victor Olaya 2018-06-01 07:00 AM No

17367 Bug report Closed Normal Offset tool doesn't honor snapping configuration Denis Rouzaud 2018-02-22 09:16 AM No
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17367 Bug report Closed Normal Offset tool doesn't honor snapping configuration Denis Rouzaud 2018-02-22 09:16 AM No

17342 Bug report Closed Low Processing: Import into PostGIS fails with mystery error message if schema doesn't exist 2018-07-22 11:07 PM No

17342 Bug report Closed Low Processing: Import into PostGIS fails with mystery error message if schema doesn't exist 2018-07-22 11:07 PM No

17327 Bug report Closed Normal Sorting of input layer Layers in Processing "multiple inputs" widgets Victor Olaya 2018-08-23 08:30 PM No

17327 Bug report Closed Normal Sorting of input layer Layers in Processing "multiple inputs" widgets Victor Olaya 2018-08-23 08:30 PM No

17300 Bug report Closed Normal Aggregate functions in Field Calculator in modeller Luigi Pirelli 2018-02-22 11:18 AM Yes

17300 Bug report Closed Normal Aggregate functions in Field Calculator in modeller Luigi Pirelli 2018-02-22 11:18 AM Yes

17295 Bug report Closed Normal vector styler in layer properties shows "This renderer doesn't implement a graphical interface" message since 2.18.12 ? 2018-05-24 01:45 AM No

17295 Bug report Closed Normal vector styler in layer properties shows "This renderer doesn't implement a graphical interface" message since 2.18.12 ? 2018-05-24 01:45 AM No

17266 Bug report Closed High Lines To Polygons, Polygonize and Refactor Fields change all attributes to string 255 2017-11-08 02:30 PM No

17266 Bug report Closed High Lines To Polygons, Polygonize and Refactor Fields change all attributes to string 255 2017-11-08 02:30 PM No

17262 Bug report Closed High Attribute table data entered text is obscured by the 'x' button Alessandro 

Pasotti

2017-11-24 02:11 PM No

17262 Bug report Closed High Attribute table data entered text is obscured by the 'x' button Alessandro 

Pasotti

2017-11-24 02:11 PM No

17232 Bug report Closed Normal The rotation widget disappearwhen you change the anchor point is modifier 2018-02-22 11:07 AM No

17232 Bug report Closed Normal The rotation widget disappearwhen you change the anchor point is modifier 2018-02-22 11:07 AM No

17183 Bug report Closed Normal 'Refactory fields' processing algorithm: double entry type Victor Olaya 2018-02-02 09:18 AM No

17183 Bug report Closed Normal 'Refactory fields' processing algorithm: double entry type Victor Olaya 2018-02-02 09:18 AM No

17175 Bug report Closed Normal Relation reference widget triggers SQL syntax error with UUID fields in Postgres Denis Rouzaud 2018-02-24 11:04 AM No

17175 Bug report Closed Normal Relation reference widget triggers SQL syntax error with UUID fields in Postgres Denis Rouzaud 2018-02-24 11:04 AM No

17131 Bug report Closed High Processing: Union and Intersection wrong results Victor Olaya 2018-06-01 04:04 AM No

17131 Bug report Closed High Processing: Union and Intersection wrong results Victor Olaya 2018-06-01 04:04 AM No

17123 Bug report Closed Normal Adding WMS/WFS/WCS layers through the browser ignores service specific settings 2018-08-15 07:35 PM No

17123 Bug report Closed Normal Adding WMS/WFS/WCS layers through the browser ignores service specific settings 2018-08-15 07:35 PM No

17024 Bug report Closed High Identify Tool gives false hits for layers with spatial index (MS SQL) Nathan 

Woodrow

2019-01-03 11:07 AM No

17024 Bug report Closed High Identify Tool gives false hits for layers with spatial index (MS SQL) Nathan 

Woodrow

2019-01-03 11:07 AM No

17004 Bug report Closed Normal Spatial bookmarks: SRID value should not be set to 0 when moving a bookmark to/from a project Alessandro 

Pasotti

2017-11-29 02:36 PM No

17004 Bug report Closed Normal Spatial bookmarks: SRID value should not be set to 0 when moving a bookmark to/from a project Alessandro 

Pasotti

2017-11-29 02:36 PM No

17003 Bug report Closed High Spatial bookmarks keyboard navigation: right-arrow causes a row to appear below the current one and looks like a tree 

expansion

Alessandro 

Pasotti

2017-12-01 07:02 PM Yes

17003 Bug report Closed High Spatial bookmarks keyboard navigation: right-arrow causes a row to appear below the current one and looks like a tree 

expansion

Alessandro 

Pasotti

2017-12-01 07:02 PM Yes

16945 Bug report Closed Normal Wrong data type of fields when adding a Spatialite layer Julien Cabieces 2019-01-14 09:54 AM No

16945 Bug report Closed Normal Wrong data type of fields when adding a Spatialite layer Julien Cabieces 2019-01-14 09:54 AM No

16943 Bug report Closed Normal Create virtual layer from OSM import fails on field names with : in them 2018-02-22 11:19 AM No

16943 Bug report Closed Normal Create virtual layer from OSM import fails on field names with : in them 2018-02-22 11:19 AM No

16925 Bug report Closed Normal Field calculator "round" function wrong results if rounding to 8 or more decimals 2018-08-25 03:13 PM No

16925 Bug report Closed Normal Field calculator "round" function wrong results if rounding to 8 or more decimals 2018-08-25 03:13 PM No

16902 Bug report Closed Normal GPKG table referenced by Id instead of layername 2017-11-10 11:47 PM No

16902 Bug report Closed Normal GPKG table referenced by Id instead of layername 2017-11-10 11:47 PM No

16838 Bug report Closed Normal snapping allows to snap non displayed legend classes Martin Dobias 2018-06-05 02:52 PM No

16838 Bug report Closed Normal snapping allows to snap non displayed legend classes Martin Dobias 2018-06-05 02:52 PM No

16748 Bug report Closed Normal Position of an attribute table object in a composer doesn't follow the predifined values 2017-12-19 12:37 AM No

16748 Bug report Closed Normal Position of an attribute table object in a composer doesn't follow the predifined values 2017-12-19 12:37 AM No

16735 Bug report Closed Normal Python Console: typing _api should open the version API documentation and not the master's 2018-09-01 11:56 AM No

16735 Bug report Closed Normal Python Console: typing _api should open the version API documentation and not the master's 2018-09-01 11:56 AM No

16731 Bug report Closed Normal Processing/GRASS tools fail if input datasource has spaces in the name Victor Olaya 2018-06-04 02:19 AM No

16731 Bug report Closed Normal Processing/GRASS tools fail if input datasource has spaces in the name Victor Olaya 2018-06-04 02:19 AM No

16730 Bug report Closed Normal python error in DB Manager when connecting to a Geopackage datasource Even Rouault 2017-11-09 03:32 PM No

16730 Bug report Closed Normal python error in DB Manager when connecting to a Geopackage datasource Even Rouault 2017-11-09 03:32 PM No

16695 Bug report Closed Normal browser panel restore causes unwanted WMS connections when expanded Alessandro 

Pasotti

2017-11-21 09:30 AM Yes

16695 Bug report Closed Normal browser panel restore causes unwanted WMS connections when expanded Alessandro 

Pasotti

2017-11-21 09:30 AM Yes

16676 Bug report Closed Normal Invalid fields error when using “Use completer” in Layer properties Edit widget:Value Relation 2017-12-05 06:39 PM Yes

16676 Bug report Closed Normal Invalid fields error when using “Use completer” in Layer properties Edit widget:Value Relation 2017-12-05 06:39 PM Yes

16657 Bug report Closed High date edit widget only shows current date whatever the real data is underneath Denis Rouzaud 2018-02-22 11:21 AM No

16657 Bug report Closed High date edit widget only shows current date whatever the real data is underneath Denis Rouzaud 2018-02-22 11:21 AM No

16615 Bug report Closed High QGIS crashes when opening project file with nonexisting NTV2 grid file location 2017-11-14 02:16 PM No

16615 Bug report Closed High QGIS crashes when opening project file with nonexisting NTV2 grid file location 2017-11-14 02:16 PM No

16580 Bug report Closed Low Date widget: cosmetic issue with NULL values Denis Rouzaud 2018-02-22 11:23 AM No

16580 Bug report Closed Low Date widget: cosmetic issue with NULL values Denis Rouzaud 2018-02-22 11:23 AM No

16579 Bug report Closed Low Date widget: current date can't be picked Denis Rouzaud 2018-02-22 11:13 AM No

16579 Bug report Closed Low Date widget: current date can't be picked Denis Rouzaud 2018-02-22 11:13 AM No

16524 Bug report Closed High Processing/geoprocessing operations failing in 2.18 with memory layers 2018-06-05 04:13 AM No

16524 Bug report Closed High Processing/geoprocessing operations failing in 2.18 with memory layers 2018-06-05 04:13 AM No

16409 Bug report Closed Low Processing script editor: incorrect read of degree symbol Victor Olaya 2018-06-01 08:18 AM No

16409 Bug report Closed Low Processing script editor: incorrect read of degree symbol Victor Olaya 2018-06-01 08:18 AM No

16350 Bug report Closed Normal Spatial Bookmark Panel: precision gets trimmed Alessandro 

Pasotti

2017-12-01 07:02 PM Yes

16350 Bug report Closed Normal Spatial Bookmark Panel: precision gets trimmed Alessandro 

Pasotti

2017-12-01 07:02 PM Yes

16319 Bug report Closed Normal DXF Export generates many numbered layers (1 layer for each feature) 2017-11-16 05:40 AM No

16319 Bug report Closed Normal DXF Export generates many numbered layers (1 layer for each feature) 2017-11-16 05:40 AM No

16274 Bug report Closed Normal Reference point property of the composer item is not working properly 2017-12-19 12:36 AM No
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16274 Bug report Closed Normal Reference point property of the composer item is not working properly 2017-12-19 12:36 AM No

16267 Bug report Closed Normal Printing Pdf's that have WMTS layers problems 2018-03-07 10:35 PM No

16267 Bug report Closed Normal Printing Pdf's that have WMTS layers problems 2018-03-07 10:35 PM No

16250 Bug report Closed Normal Processing ogr tools problems in QGIS 2.18.10 when special chars are in input file names Luigi Pirelli 2018-06-01 07:49 AM Yes

16250 Bug report Closed Normal Processing ogr tools problems in QGIS 2.18.10 when special chars are in input file names Luigi Pirelli 2018-06-01 07:49 AM Yes

16183 Bug report Closed Low Bookmark remove dialog German translation issue QGIS 

Translation 

Team

2017-11-27 01:19 AM No

16183 Bug report Closed Low Bookmark remove dialog German translation issue QGIS 

Translation 

Team

2017-11-27 01:19 AM No

16178 Bug report Closed Normal GDAL algorithms ignore feature filter Victor Olaya 2018-06-18 02:01 AM No

16178 Bug report Closed Normal GDAL algorithms ignore feature filter Victor Olaya 2018-06-18 02:01 AM No

16054 Bug report Closed Normal Save as... save only visibles features if 'show features visible on map' is activated 2018-02-28 10:42 AM No

16054 Bug report Closed Normal Save as... save only visibles features if 'show features visible on map' is activated 2018-02-28 10:42 AM No

16014 Bug report Closed Normal Enabling actions in attribute table populates the first column with actions and hides values 2018-02-23 05:24 PM No

16014 Bug report Closed Normal Enabling actions in attribute table populates the first column with actions and hides values 2018-02-23 05:24 PM No

15937 Bug report Closed Normal Adding label of Joined Layer looses all features 2018-08-12 01:45 PM No

15937 Bug report Closed Normal Adding label of Joined Layer looses all features 2018-08-12 01:45 PM No

15913 Bug report Closed Normal Bug when using NIght Mapping inside Raster Style - Band Rendering 2018-12-28 03:05 PM No

15913 Bug report Closed Normal Bug when using NIght Mapping inside Raster Style - Band Rendering 2018-12-28 03:05 PM No

15904 Bug report Closed Normal WFS 2.18.1 slow with PostGIS layer 2018-09-27 09:23 AM No

15904 Bug report Closed Normal WFS 2.18.1 slow with PostGIS layer 2018-09-27 09:23 AM No

15875 Bug report Closed Normal Importing a POINT layer in Browser always returns MULTIPOINT Alessandro 

Pasotti

2018-03-01 11:08 AM Yes

15875 Bug report Closed Normal Importing a POINT layer in Browser always returns MULTIPOINT Alessandro 

Pasotti

2018-03-01 11:08 AM Yes

15768 Bug report Closed Normal DB Manager - Update SQL layer is not available when using column with unique values 2018-03-01 11:05 AM No

15768 Bug report Closed Normal DB Manager - Update SQL layer is not available when using column with unique values 2018-03-01 11:05 AM No

15754 Bug report Closed Normal editing several layers in geopackage - database is locked 2017-11-21 01:30 PM No

15754 Bug report Closed Normal editing several layers in geopackage - database is locked 2017-11-21 01:30 PM No

15749 Bug report Closed Normal Processing: gdal merge converts no data in 0 Giovanni 

Manghi

2018-02-24 04:30 PM No

15749 Bug report Closed Normal Processing: gdal merge converts no data in 0 Giovanni 

Manghi

2018-02-24 04:30 PM No

15709 Bug report Closed Normal bad match of valeurs with virtual layer 2018-10-26 02:03 PM No

15709 Bug report Closed Normal bad match of valeurs with virtual layer 2018-10-26 02:03 PM No

15697 Bug report Closed Normal r.fillnulls fails to work in processing toolbox 2018-06-01 08:58 AM No

15697 Bug report Closed Normal r.fillnulls fails to work in processing toolbox 2018-06-01 08:58 AM No

15680 Bug report Closed High Clipping of raster with GDAL may hang QGIS Victor Olaya 2017-11-10 09:06 AM No

15680 Bug report Closed High Clipping of raster with GDAL may hang QGIS Victor Olaya 2017-11-10 09:06 AM No

15642 Bug report Closed Normal Print composer:  Changing "orientation" in Page Setup has no effect 2017-12-19 01:13 AM No

15642 Bug report Closed Normal Print composer:  Changing "orientation" in Page Setup has no effect 2017-12-19 01:13 AM No

15640 Bug report Closed Normal Refactor fields: an expression is always required (otherwise python error is thrown) 2018-02-27 09:32 PM No

15640 Bug report Closed Normal Refactor fields: an expression is always required (otherwise python error is thrown) 2018-02-27 09:32 PM No

15619 Bug report Closed Normal ERS format not available in drop down file type menu for gdalwarp and gdal_translate 2018-02-22 02:55 PM No

15619 Bug report Closed Normal ERS format not available in drop down file type menu for gdalwarp and gdal_translate 2018-02-22 02:55 PM No

15569 Bug report Closed Normal Size assistant fails to calculate min max from layer 2018-02-26 02:26 AM No

15569 Bug report Closed Normal Size assistant fails to calculate min max from layer 2018-02-26 02:26 AM No

15553 Bug report Closed Normal QGIS Server OPACITIES parameter works only when STYLES parameter is default 2018-09-12 04:10 PM No

15553 Bug report Closed Normal QGIS Server OPACITIES parameter works only when STYLES parameter is default 2018-09-12 04:10 PM No

15545 Bug report Closed Normal Vertical or horizontal Polyline in Composer doesn't show up (if not selected) and cannot be edited (but exported) 2017-12-18 11:42 PM No

15545 Bug report Closed Normal Vertical or horizontal Polyline in Composer doesn't show up (if not selected) and cannot be edited (but exported) 2017-12-18 11:42 PM No

15333 Bug report Closed Normal Map composer - attribute table linked with overwiev another map view is not refreshing up after changing of map view 2017-12-19 01:11 AM No

15333 Bug report Closed Normal Map composer - attribute table linked with overwiev another map view is not refreshing up after changing of map view 2017-12-19 01:11 AM No

15247 Bug report Closed Normal 'Snap geometries' plugin creates duplicate nodes Sandro Mani 2018-02-22 11:50 AM No

15247 Bug report Closed Normal 'Snap geometries' plugin creates duplicate nodes Sandro Mani 2018-02-22 11:50 AM No

15227 Bug report Closed Normal Attribute table issue when entering a new value 2018-03-06 12:01 PM No

15227 Bug report Closed Normal Attribute table issue when entering a new value 2018-03-06 12:01 PM No

15206 Bug report Closed Normal Print layout: remove empty groups 2018-02-25 06:35 PM No

15206 Bug report Closed Normal Print layout: remove empty groups 2018-02-25 06:35 PM No

15194 Bug report Closed Normal Snapping multiple items in print composer 2018-02-23 03:36 PM No

15194 Bug report Closed Normal Snapping multiple items in print composer 2018-02-23 03:36 PM No

15080 Bug report Closed Normal Impossible to clear geometries of features that have circular strings in temporary scratch layer 2018-02-27 07:01 PM No

15080 Bug report Closed Normal Impossible to clear geometries of features that have circular strings in temporary scratch layer 2018-02-27 07:01 PM No

15019 Bug report Closed Normal Paths should be fully adjusted to each OS 2018-03-07 12:36 PM No

15019 Bug report Closed Normal Paths should be fully adjusted to each OS 2018-03-07 12:36 PM No

14978 Bug report Closed Normal Join attributes in Processing works in a slightly different way compared to core tool 2018-04-19 06:34 AM No

14978 Bug report Closed Normal Join attributes in Processing works in a slightly different way compared to core tool 2018-04-19 06:34 AM No

14847 Bug report Closed Normal Print composer: moving a grouped rotated map resizes places it wrongly 2018-02-25 06:56 PM No

14847 Bug report Closed Normal Print composer: moving a grouped rotated map resizes places it wrongly 2018-02-25 06:56 PM No

14776 Bug report Closed Normal [composer] Incorrect world file generated if dpi changed in image export options dialog 2017-12-19 12:42 AM No

14776 Bug report Closed Normal [composer] Incorrect world file generated if dpi changed in image export options dialog 2017-12-19 12:42 AM No

14752 Bug report Closed High GEOS exceptions crash QGIS on windows 2018-07-22 11:26 PM No

14752 Bug report Closed High GEOS exceptions crash QGIS on windows 2018-07-22 11:26 PM No

14730 Bug report Closed Normal File picker window slow 2018-06-01 04:01 AM No

14730 Bug report Closed Normal File picker window slow 2018-06-01 04:01 AM No

14694 Bug report Closed Low  DB Manager: F5 not working 2018-02-25 05:01 PM No

14694 Bug report Closed Low  DB Manager: F5 not working 2018-02-25 05:01 PM No

14564 Bug report Closed Normal Tooltip type changed automatically 2018-02-25 07:17 PM No
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14564 Bug report Closed Normal Tooltip type changed automatically 2018-02-25 07:17 PM No

14504 Bug report Closed Normal The QGIS intersection tool yields incomplete results 2018-06-05 04:07 AM No

14504 Bug report Closed Normal The QGIS intersection tool yields incomplete results 2018-06-05 04:07 AM No

14004 Bug report Closed Low Night Mapping Theme - Small refinements Nathan 

Woodrow

2018-12-28 09:47 AM No

14004 Bug report Closed Low Night Mapping Theme - Small refinements Nathan 

Woodrow

2018-12-28 09:47 AM No

13917 Bug report Closed Normal Names of Print layout items not reused 2018-03-07 05:07 PM No

13917 Bug report Closed Normal Names of Print layout items not reused 2018-03-07 05:07 PM No

13914 Bug report Closed Normal Rephrase Draw map canvas items 2018-02-25 06:59 PM No

13914 Bug report Closed Normal Rephrase Draw map canvas items 2018-02-25 06:59 PM No

13913 Bug report Closed High Embed layers and groups does not work properly with layer duplicate names 2018-12-28 04:33 PM No

13913 Bug report Closed High Embed layers and groups does not work properly with layer duplicate names 2018-12-28 04:33 PM No

13890 Bug report Closed Normal Font size in Form view does not take into account default font size settings 2018-03-07 04:51 PM No

13890 Bug report Closed Normal Font size in Form view does not take into account default font size settings 2018-03-07 04:51 PM No

13856 Bug report Closed Low DB Manager: SET DEFAULT syntax wrong 2018-03-08 05:19 PM No

13856 Bug report Closed Low DB Manager: SET DEFAULT syntax wrong 2018-03-08 05:19 PM No

13851 Bug report Closed Normal Scalebar addition when dealing with multiple map frames 2017-12-02 06:28 PM No

13851 Bug report Closed Normal Scalebar addition when dealing with multiple map frames 2017-12-02 06:28 PM No

13436 Bug report Closed Normal Let user set histograms in mm 2018-02-25 05:27 PM No

13436 Bug report Closed Normal Let user set histograms in mm 2018-02-25 05:27 PM No

13427 Bug report Closed Normal Range widget not working with NULLs 2018-03-07 05:50 PM No

13427 Bug report Closed Normal Range widget not working with NULLs 2018-03-07 05:50 PM No

13280 Bug report Closed Normal While exporting composer, WMS warning appears only if WMS layer is visible in the map canvas Nyall Dawson 2017-12-19 12:41 AM No

13280 Bug report Closed Normal While exporting composer, WMS warning appears only if WMS layer is visible in the map canvas Nyall Dawson 2017-12-19 12:41 AM No

13120 Bug report Closed Normal Processing gdal tools do not work if Windows username contain non ascii chars. 2018-06-01 07:50 AM No

13120 Bug report Closed Normal Processing gdal tools do not work if Windows username contain non ascii chars. 2018-06-01 07:50 AM No

13041 Bug report Closed Normal Processing Toolbox Doesn't Pick Up New Database Connections 2018-01-23 10:52 PM No

13041 Bug report Closed Normal Processing Toolbox Doesn't Pick Up New Database Connections 2018-01-23 10:52 PM No

12759 Bug report Closed Normal Advanced digitizing: two panels with the same name 2018-01-26 12:37 PM No

12759 Bug report Closed Normal Advanced digitizing: two panels with the same name 2018-01-26 12:37 PM No

12751 Bug report Closed Normal When advanced (CAD) digitizing is ON, Overview panel cannot be resized 2018-03-07 04:52 PM No

12751 Bug report Closed Normal When advanced (CAD) digitizing is ON, Overview panel cannot be resized 2018-03-07 04:52 PM No

12712 Bug report Closed Normal Composer map doesn't rotate when angle is set using "data define override" option 2017-12-19 12:03 AM No

12712 Bug report Closed Normal Composer map doesn't rotate when angle is set using "data define override" option 2017-12-19 12:03 AM No

12678 Bug report Closed Normal coverage layer not checked before parsing filename expression in atlas generation Nyall Dawson 2018-02-27 06:52 PM No

12678 Bug report Closed Normal coverage layer not checked before parsing filename expression in atlas generation Nyall Dawson 2018-02-27 06:52 PM No

12656 Bug report Closed Normal Style Manager filter ignores currently selected group 2019-01-14 09:24 AM No

12656 Bug report Closed Normal Style Manager filter ignores currently selected group 2019-01-14 09:24 AM No

12623 Bug report Closed Normal Project templates should be stored relative to config folder 2018-03-07 10:01 PM No

12623 Bug report Closed Normal Project templates should be stored relative to config folder 2018-03-07 10:01 PM No

12502 Bug report Closed Normal processing:runalg locks input file Victor Olaya 2018-06-01 07:50 AM No

12502 Bug report Closed Normal processing:runalg locks input file Victor Olaya 2018-06-01 07:50 AM No

12259 Bug report Closed Low Window for the creation of new memory layers: wrong size 2018-02-25 07:25 PM No

12259 Bug report Closed Low Window for the creation of new memory layers: wrong size 2018-02-25 07:25 PM No

12079 Bug report Closed Normal Identify highlight color does not take alpha channel into account 2018-10-23 11:45 AM No

12079 Bug report Closed Normal Identify highlight color does not take alpha channel into account 2018-10-23 11:45 AM No

12003 Bug report Closed Normal crssync sensitive to locale behavior while installing 2018-09-23 10:20 PM No

12003 Bug report Closed Normal crssync sensitive to locale behavior while installing 2018-09-23 10:20 PM No

11903 Bug report Closed Low Configure Shortcuts problem on Mac 2018-08-12 01:37 PM No

11903 Bug report Closed Low Configure Shortcuts problem on Mac 2018-08-12 01:37 PM No

11790 Bug report Closed High Python bindings for QgsDxfExport.addLayers causes crash 2018-02-22 11:40 AM Yes

11790 Bug report Closed High Python bindings for QgsDxfExport.addLayers causes crash 2018-02-22 11:40 AM Yes

11656 Bug report Closed Normal Inconsistent icons 2018-05-06 12:43 PM No

11656 Bug report Closed Normal Inconsistent icons 2018-05-06 12:43 PM No

11416 Bug report Closed Normal Adding geojson via add vector layer causes strange behaviour 2018-03-19 08:43 PM No

11416 Bug report Closed Normal Adding geojson via add vector layer causes strange behaviour 2018-03-19 08:43 PM No

11348 Bug report Closed Normal Add PostGIS layers is too slow on connecting to a database Harry Clarke 2018-08-12 01:46 PM No

11348 Bug report Closed Normal Add PostGIS layers is too slow on connecting to a database Harry Clarke 2018-08-12 01:46 PM No

11317 Bug report Closed Normal PostGIS views not handled correctly 2018-08-10 12:07 PM No

11317 Bug report Closed Normal PostGIS views not handled correctly 2018-08-10 12:07 PM No

11286 Bug report Closed Normal Incorrect evaluation of Rule-Base features 2018-08-12 02:36 PM No

11286 Bug report Closed Normal Incorrect evaluation of Rule-Base features 2018-08-12 02:36 PM No

11228 Bug report Closed Normal resolution problem with the rule rendering dialog window 2018-08-08 11:48 AM No

11228 Bug report Closed Normal resolution problem with the rule rendering dialog window 2018-08-08 11:48 AM No

11098 Bug report Closed Low Grey  "Export symbology" option in the "save vector layer as ..."  CSV 2018-02-22 11:52 AM No

11098 Bug report Closed Low Grey  "Export symbology" option in the "save vector layer as ..."  CSV 2018-02-22 11:52 AM No

10971 Bug report Closed Low Map composer: map updates 2018-02-25 05:31 PM No

10971 Bug report Closed Low Map composer: map updates 2018-02-25 05:31 PM No

10658 Bug report Closed Normal Repeated Layer name 2018-02-24 04:41 PM No

10658 Bug report Closed Normal Repeated Layer name 2018-02-24 04:41 PM No

10536 Bug report Closed Normal The toggle editing pencil becomes orange without changing values of the layer 2018-02-27 07:41 PM No

10536 Bug report Closed Normal The toggle editing pencil becomes orange without changing values of the layer 2018-02-27 07:41 PM No

10346 Bug report Closed Normal progress bar and setText not working on a mac with user script Victor Olaya 2018-02-23 03:37 PM No

10346 Bug report Closed Normal progress bar and setText not working on a mac with user script Victor Olaya 2018-02-23 03:37 PM No

10237 Bug report Closed Normal project loads layers not seen in legend 2018-08-22 09:55 PM No

10237 Bug report Closed Normal project loads layers not seen in legend 2018-08-22 09:55 PM No

10155 Bug report Closed Normal Right to Left formating in Map Composer 2018-05-14 05:55 PM No

10155 Bug report Closed Normal Right to Left formating in Map Composer 2018-05-14 05:55 PM No

10045 Bug report Closed Normal Error upon upgrading Processing (possibly other complex plugins) Borys Jurgiel 2018-01-25 08:47 PM No
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10045 Bug report Closed Normal Error upon upgrading Processing (possibly other complex plugins) Borys Jurgiel 2018-01-25 08:47 PM No

10017 Bug report Closed Normal No vertical scrollbar for high forms and bad display when maximized 2018-02-28 03:03 PM No

10017 Bug report Closed Normal No vertical scrollbar for high forms and bad display when maximized 2018-02-28 03:03 PM No

9926 Bug report Closed Normal SRS 102003 not recognized 2018-02-24 02:29 PM No

9926 Bug report Closed Normal SRS 102003 not recognized 2018-02-24 02:29 PM No

9801 Bug report Closed Normal Map rotation in print composer: make behaviour more uniform Nyall Dawson 2018-02-24 02:22 PM No

9801 Bug report Closed Normal Map rotation in print composer: make behaviour more uniform Nyall Dawson 2018-02-24 02:22 PM No

9798 Bug report Closed Normal wrong rendering of line pattern fill (custom dash pattern) 2018-02-24 05:13 PM No

9798 Bug report Closed Normal wrong rendering of line pattern fill (custom dash pattern) 2018-02-24 05:13 PM No

9667 Bug report Closed Normal Using PostGIS over a slow connection unfeasible: unnecessary loading of data? 2018-02-24 05:25 PM No

9667 Bug report Closed Normal Using PostGIS over a slow connection unfeasible: unnecessary loading of data? 2018-02-24 05:25 PM No

9310 Bug report Closed Normal Save dialogue for Geoprocessing outputs is inconsistent 2018-06-01 07:47 AM No

9310 Bug report Closed Normal Save dialogue for Geoprocessing outputs is inconsistent 2018-06-01 07:47 AM No

9304 Bug report Closed Normal Names of colour ramp categories 2018-02-24 02:03 PM No

9304 Bug report Closed Normal Names of colour ramp categories 2018-02-24 02:03 PM No

9232 Bug report Closed Normal do not list non-geometric layers in layer order Martin Dobias 2018-02-21 09:41 PM No

9232 Bug report Closed Normal do not list non-geometric layers in layer order Martin Dobias 2018-02-21 09:41 PM No

9008 Bug report Closed Normal Postgis: commit errors leads to loosing data 2018-02-25 11:09 AM No

9008 Bug report Closed Normal Postgis: commit errors leads to loosing data 2018-02-25 11:09 AM No

8937 Bug report Closed Normal Help in Save raster as... help dialog 2018-02-24 01:58 PM No

8937 Bug report Closed Normal Help in Save raster as... help dialog 2018-02-24 01:58 PM No

8897 Bug report Closed Normal Results from field calculator wrong format 2018-05-16 05:49 PM No

8897 Bug report Closed Normal Results from field calculator wrong format 2018-05-16 05:49 PM No

8854 Bug report Closed Normal Browser not accessing Windows network 2018-02-24 05:11 PM No

8854 Bug report Closed Normal Browser not accessing Windows network 2018-02-24 05:11 PM No

8699 Bug report Closed Normal Context help - "?" in panel header all empty 2018-05-16 05:50 PM No

8699 Bug report Closed Normal Context help - "?" in panel header all empty 2018-05-16 05:50 PM No

8690 Bug report Closed Normal Toolbox misaligned 2018-05-16 05:51 PM No

8690 Bug report Closed Normal Toolbox misaligned 2018-05-16 05:51 PM No

8677 Bug report Closed Low More consistent buttons for adding expressions 2018-02-24 01:45 PM No

8677 Bug report Closed Low More consistent buttons for adding expressions 2018-02-24 01:45 PM No

8002 Bug report Closed Normal Voronoi Polygons tool makes overlapped polygons 2018-08-29 11:37 AM Yes

8002 Bug report Closed Normal Voronoi Polygons tool makes overlapped polygons 2018-08-29 11:37 AM Yes

6945 Bug report Closed Normal SAGA vector produced without .prj if the input layer does not have it 2018-02-24 11:08 AM No

6945 Bug report Closed Normal SAGA vector produced without .prj if the input layer does not have it 2018-02-24 11:08 AM No

6898 Bug report Closed Normal QGIS mapserver forces http when requesting SLD=https René-Luc 

ReLuc

2018-09-10 02:03 PM Yes

6898 Bug report Closed Normal QGIS mapserver forces http when requesting SLD=https René-Luc 

ReLuc

2018-09-10 02:03 PM Yes

5590 Bug report Closed Normal Arrow in composer - "bounding box" corners 2017-12-18 11:57 PM No

5590 Bug report Closed Normal Arrow in composer - "bounding box" corners 2017-12-18 11:57 PM No
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